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Date Version Changes
10/05/2016 | 2016.3 Validated for Vivado® Design Suite 2016.3. Changes include:
e Updated screencaptures
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Implementation Tutorial

i} IMPORTANT: This tutorial requires the use of the Kintex®-7 and Kintex UltraScale™ family
of devices. You will need to update your Vivado® Design Suite tools installation if you do
not have this device family installed. Refer to the Vivado Design Suite User Guide: Release
Notes, Installation, and Licensing (UG973) for more information on Adding Design Tools or
Devices.

Overview

This tutorial includes four labs that demonstrate different features of the Xilinx® Vivado® Design Suite
implementation tool:

e Lab 1 demonstrates using implementation strategies to meet different design objectives.

e Lab 2 demonstrates the use of the incremental compile feature to quickly make small design
changes to a placed and routed design.

e Lab 3 demonstrates the use of manual placement and routing, and duplicated routing, to fine-
tune the timing on the design.

e Lab 4 demonstrates the use of the Vivado ECO to make quick changes to your design post
implementation.

Vivado implementation includes all steps necessary to place and route the netlist onto the FPGA device
resources, while meeting the logical, physical, and timing constraints of a design.

-
>

m VIDEO: You can also learn more about implementing the design by viewing the following
Quick Take videos:

e Vivado Quick Take Video: Implementing the Design

e Vivado Quick Take Video: Using Incremental Implementation in Vivado

TRAINING: Xilinx provides training courses that can help you learn more about the
concepts presented in this document. Use these links to explore related courses:

:| e Essentials of FPGA Design

e Vivado Design Suite Static Timing Analysis and Xilinx Design Constraints

¢ Advanced Tools and Techniques of the Vivado Design Suite
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Tutorial Design Description

The design used for Lab #1 is the CPU Netlist example design, project_cpu_netlist_kintex7,
provided with the Vivado Design Suite installation. This design uses a top-level EDIF netlist source file,
and an XDC constraints file.

The design used for Lab #2 and Lab #3 is the BFT Core example design, project_bft_kintex7. This
design includes both Verilog and VHDL RTL files, as well as an XDC constraints file.

The design used for Lab #4 is available as a Reference Design from the Xilinx website. See
information in Locating Design Files for Lab 4.

The CPU Netlist and BFT Core designs target an XC7K70T device, and the design for Lab #4 targets an
XCKUO040 device. Running the tutorial with small designs allows for minimal hardware requirements and
enables timely completion of the tutorial, as well as minimizing data size.

Hardware and Software Requirements

This tutorial requires that the 2016.3 Vivado Design Suite software release or later is installed.

Refer to the Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973) for a
complete list and description of the system and software requirements.

Preparing the Tutorial Design Files

Locating Design Files for Labs 1-3

You can find the files for Labs 1-3 in this tutorial in the Vivado Design Suite examples directory at the
following location:

<Vivado_install_area>/Vivado/<version>/examples/Vivado_Tutorial

You can also extract the provided zip file, at any time, to write the tutorial files to your local directory, or
to restore the files to their starting condition.

Extract the zip file contents from the software installation into any write-accessible location.

<Vivado_install_area>/Vivado/<version>/examples/Vivado_Tutorial.zip
The extracted Vivado_Tutorial directory is referred to as <Extract_Dir> in this tutorial.

Note: You will modify the tutorial design data while working through this tutorial. You should use a
new copy of the original Vivado_Tutorial directory each time you start this tutorial.
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Implementation Tutorial

Locating Design Files for Lab 4

To access the reference design for Lab #4, do the following:
1. Inyour C: drive, create a folder called /Vivado_Tutorial.

2. Download the Reference Design Files from this link on the Xilinx website.

3. Unzip the tutorial source file to the /Vivado_Tutorial folder.
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Lab 1: Using Implementation Strategies

Introduction

In this lab, you will learn how to use implementation strategies with design runs by creating multiple
implementation runs employing different strategies, and comparing the results. You will use the CPU
Netlist example design that is included in the Vivado® IDE.

Step 1: Opening the Example Project

1. Open the Xilinx® Vivado IDE.
On Linux:

a. Change to the directory where the lab materials are stored:
cd <Extract Dir>/Vivado_Tutorial

b. Launch the Vivado IDE: vivado
On Windows:

a. Launch the Vivado Design Suite IDE:
Start > All Programs > Xilinx Design Tools > Vivado 2016.x > Vivado 2016.x

Note: Your Vivado Design Suite installation might be called something other than Xilinx Design
Tools on the Start menu.

Note: As an alternative, click the Vivado 2016.x Desktop icon to start the Vivado IDE.

The Vivado IDE Getting Started page contains links to open or create projects and to view
documentation.

b. From the Getting Started page, click Open Example Project.

Quick Start
yir ' ' "
=l
LY =
Create New Project Open Project Open Example Project
Tasks

e @

Manage IP Open Hardware Manager Xilinx Tcl Store

Figure 1: Open Example Design
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2. Click Next in the Open Example Project screen.

¢ Open Example Project
Create an Example Project
[
V|VAD O This wizard will guide you through the creation of a new Vivado project from a predefined template.
HLx Editians

To create a Vivado project you will specify the type of template project you would like to create. Next, you
will need to provide a name and a location for your project files and choose a default board.

To continue, click Next.

=

Figure 2: Open Example Project, Create an Example Project Screen
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3. In the Select Example Project screen, choose the CPU (Synthesized) project and click Next.

e

=

¢ Open Example Project
Select Project Template
Select one of the below predefined templates on which to base your new project ‘

Templates Description

Base MicroBlaze CPU {Synthesized)
Base Zyng

BFT

Configurable Microblaze Design
CPU (HODL)

Wavegen (HDL)

Large synthesized netlist project

TR T

Figure 3: Open Example Project, Select Example Project Screen
4. In the Project Name screen, specify the following:
0 Project name: project_cpu_netlist

0 Project location: <Project_Dir>
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5. Click Next.
¢ Open Example Project | &8 |
Project Name
Enter a name for your project and specify a directory where the project data files will be stored ‘
Project name: | project_cpu_netlist
Project Jocation: | C:/Data/Vivado_Tutorial B

Create project subdirectory

Project will be created at: C:/Data/Vivado_Tutorial/project_cpu_netlist

[ < Back “ Mext = Finish

Figure 4: Project Name Screen
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6. Inthe Default Part screen, select the xc7k70tfbg676-2 part and click Next.

Lab 1: Using Implementation Strategies

¢ Open Example Project
Default Part
Choose a default Xilinx part for your project. This can be changed later.

[ < Back ” Next =

(=]
¥

/O Pin Block ) GTPE2 Gb Available LUT
Part Count RAMS DSFs AR | e | e Elements
i xc7k70tfbg676-2 82000 o |8 [sgoo J4i000

Finish

Cancel

Figure 5: Default Part Screen
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7. A summary page appears, allowing you to review project details. Click Finish to return to the Vivado
IDE.

=

¢ Open Example Project

New Project Summary

VIVADO!

HLx Editions (@) A new project named 'project_cpu_netlist’ will be created from the 'CPU (Synthesized)' template.

(D) The default part and product family for the new project:
Default Part: xc7k70tfbg676-2
Product: Kintex-7
Family: Kintex-7
Package: fbg676
Speed Grade: -2

& XILINX

ALL PROGRAMMABLE. To create the project, click Finish

Next = Finish ]’ Cancel

Figure 6: New Project Summary Screen
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The Vivado IDE displays the default view of the opened project, as shown in the following figure:

E Project Summary x R
Project Settings Edit
Project name: project_cpu_netlist

Project location: C:/Data/Vivado_Tutorial/project_cpu_netlist

Product family: Kintex-7

Project part: xc7k70tfbgb76-2

Top module name:  fop
Target language: VHDL
Simulator language: Mixed

Implementation

Status: Mot started

Messages: No errors or warnings

Part: xc7k70tfbgo76-2

Strategy: Vivado Implementation Defaults
Constraints: constrs 2

Incremental compile: None

DRC Viclations Timing
Run Implementation to see DRC results Run Implementation to see timing results

Utilization Power
Run Implementation to see utilization results Run Implementation to see power results

Figure 7: Project Summary Window

Step 2: Creating Additional Implementation Runs

The project contains previously defined implementation runs as seen in the Design Runs window of the
Vivado IDE. You will create new implementation runs and change the implementation strategies used
by these new runs.

1. From the main menu, select Flow > Create Runs.
2. The Create New Runs wizard opens.
3. Click Next to open the Configure Implementation Runs screen.

The screen appears with a new implementation run defined. You can configure this run and add
other runs as well.

4. In the Strategy drop-down menu, select Performance_Explore as the strategy for the run.

+

5. Click the Add button twice to create two additional runs.
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6. Select Flow_RunPhysOpt as the Strategy for the impl_3 run.

7. Select Flow_RuntimeOptimized as the Strategy for the impl_4 run.

The Configure Implementation Runs screen now displays three new implementations along with the
strategy you selected for each, as shown in the below figure.

¢ Create New Runs
Configure Implementation Runs

Create Implementation Runs

+ Name Constraints Set

- impl_2 = constrs_2 (active)
impl_3 i constrs_2 (active)
impl_4 iz constrs_2 (active)

Fart

@ xc7k70tfog676-2
@ xc7k70tfbg676-2
@ xc7k70tfbg676-2

Create and configure one or more implementation runs using various parts, constraints, flows and strategies

Strategy
A Performance_Explore (Vivado Implementation 2016)

A& Flow_RunPhysOpt (Vivado Implementation 2016)

li*JFlows_RuntimeOptimized (Vivado Implementation 2016) [Rd

-

-

- f Congestion_SpreadLogic_medium
- Congestion_SpreadLogic_low
- Congestion_SpreadLogic_Explore
- Congestion_S51_SpreadLogic_high
- Congestion_S51_SpreadLogic_low
#& Congestion_SSI_SpreadLogic_Explore
- f Area_Explore
- Area_ExploreSequential
- Area_ExploreWithRemap
& Power_DefaultOpt
- J Power_ExploreArea
-4 Flow_RunPhysopt

A& Flow_RunPostRoutePhysOpt
] F'*)w_RuntimeOtimized
- S Fibw_Quick

-

m

=X
g

Make Active
]
O
]

Runs to create: 3

Cancel

Figure 8: Configure Implementation Runs

8. Click Next to open the Launch Options screen.

9. Select Do not launch now, and click Next to view the Create New Runs Summary.

10. In the Create New Runs Summary page, click Finish.
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Step 3: Analyzing Implementation Results

1. In the Design Runs window, select all the implementation runs.

C\ MName Part Constraints Strategy Status

Vivado Implementation Defaults (Vivado Implemen... |Not started
constrs_2 Performance_Explore (Vivado Implementation 2014) Mot started

onstrs_2 Flow_RunPhysOpt (Vivado Implementation 2014) Mot started
Flow_RuntimeOptimized (Vivado Implementation 2014) Mot started

| i

Progress Start

Td Console LD Messages Ll:ﬂ Log @ Reportkj) Design Runs ]

Figure 9: Design Runs Window

2. On the sidebar menu, click the Launch Selected Runs button 1}.

3. In the Launch Selected Runs dialog box, select Launch runs on local host and Number of jobs: 2,

as shown below.

-

#% Launch Selected Runs @
Launch directory: | & <Default Launch Directory= -

Options

| Launch runs on local host:  Number of jobs:|2  ~
(7) Generate scripts only

Runs to Launch: 4
= impl_1
~= impl_2
~= impl_3

[ ok || cancel |

Figure 10: Launch Selected Runs
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4. Click OK.

Two runs launch simultaneously, with the remaining runs going into a queue.

A, | Name Part Constraints  Strategy Status Progress

Vivado Implementation Defaults (Vivado Implemen... |Running opt_design...
Performance_Explore (Vivado Implementation 2014) Running opt_design. ..

/= Td Console LD Messages LEQ Log lé Repcrik\ 3> Design Runs I

Figure 11: Two Implementation Runs in Progress

When the active run, impl_1, completes, examine the Project Summary. The Project Summary
reflects the status and the results of the active run. When the active run (impl_1) is complete, the
Implementation Completed dialog box opens.

5. Click Cancel to close the dialog box.

Note: The implementation utilization results display as a bar graph at the bottom of the summary
page (you might need to scroll down), as shown in the following figure.

»

Utilization

FF 1900
LT A 49%
Memory LUT 7 1%
/O 320
BR AM A 81%
DSP43 A 28%
BlLUFG 38%
WMCIV 5 17%
GT A 80%

0 25 50 75 100
Utilization (%)

Graph Table

Figure 12: Post-Implementation Utilization

When you open an implementation run, the report_power and the report_timing_summary results
are automatically opened for the run in a new tab in the Results Window.
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6. When all the implementation runs are complete, select the Design Runs tab.

7. Right-click the impl_3 run in the Design Runs window, and select Make Active from the popup

menu.

The Project Summary now displays the status and results of the new active run, impl_3.

Design Runs
N Name
=of impl_1

0
“of impl_4

Lewvz v M

<=

2 Td Console

8. Compare the results for the completed runs in the Design Runs window, as shown in Figure 13.

o |mgl_2

= Messages | [ Log

Strategy

Status

Vivado Implementation Defaults (Vivado Implementation 2016) route_design Complete!

Performance

1

3 Reports-. 3 Design Runs

route_esign Complete!

? — 0O 2
Constraints ~ Elapsed  WNS  TNS
constrs_2 00:14:39  0.100 0.000
constrs_2 00:15:48  0.100 0.000 .
00:12:50]_0.100{ _0.000] 0.
constrs_2 00:11:14  0.299 0.000 .|

Figure 13: Compare Implementation Results

e The Flow_RuntimeOptimized strategy in impl_1 completed in the least amount of time, as you
can see in the Elapsed time column.

e The WNS column shows that all runs met the timing requirements.

Step 4: Tightening Timing Requirements

To examine the impact of the Performance_Explore strategy on meeting timing, you will change the

timing constraints to make timing closure more challenging.

1. In the Sources window, double-click the top_full l . xdc file in the constrs_2 constraint set.

The constraints file opens in the Vivado IDE text editor.

#

i

liiy' =

TR

X

Implementation

1l 4 Define the

2 create clock
3

4 § Define the
5create clock
6 create clock
Tcreate clock
g create clock

9

¥ Project Summary X | {5 top_fullxde X
i C:/Data/project_cpu_netistfproject_cpu_netlist.sres/constrs_2fimportsfSources top_full. xdc

e T

clock of the

design

-pericd 10 -name 3yallk [get ports 3yaClk]

clocks
—name
—name
—name

—name

UG986 (v2016.4) November 30, 2016

gtl_txusrclk i
gtZ_txusrclk i
gtd_txusrclk i
gté_txusrclk i

Figure 14:

e GIX blocks

-period 12.8 [get pins
-period 12.8 [get pins
-period 12.8 [get pins
-period 12.8 [get pins

top_full.xdc File
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2. Online 2, change the period of the create_clock constraint from 10 ns to 7 .45 ns.
The new constraint should read as follows:
create_clock -period 7.45 -name sysClk [get_ports sysCIk]
3. Save the changes by clicking the Save File =8 button in the sidebar menu of the text editor.

Note: Saving the constraints file changes the status of all runs using that constraints file from
“Complete” to “Out-of-date,” as seen in the Design Runs window.

Design Runs ? 02 X
a4 MName Strategy Status Constraints  Elapsed WHNS  THNS WH;
=
pé Vivado Implementation Defaults (Vivado Implementation 2016) Implementation Out-of-date constrs_2 00:14:39  0.100 0.000 0.
e Performance_Explore (Vivado Implementation 2016) Implementation Out-of-date constrs_2 00:15:48 0.100 0.000 0.
|3 (active) FAow_RunPhysOpt (Vivade Implementation 2016) Implementation Out-of-date constrs_2 00:12:50 0.100 0.000 0.1
Flow_RuntimeOptimized (Vivado Implementation 2016} Implementation OQut-of-date constrs_2 00:11:14  0.299 0.000 0.

Ed

‘ 1] v
2 Tel Console | © Messages | B Log | ) Reports 3 Design Runs

Figure 15: Implementation Runs Out-of-Date

4. In the Design Runs window, select all runs and click the Reset Runs 4 button.

5. In the Reset Runs dialog box, enable the Delete the generated files in the working directory
checkbox and click Reset.

This checkbox directs the Vivado Design Suite to remove all files associated with the selected runs
from the project directory. The status of all runs changes from "Out-of-date” to “Not started.”

6. With all runs selected in the Design Runs window, click the Launch Selected Runs D button.

The Launch Selected Runs window opens.

O TIP: You can also launch runs without resetting them first. If the runs are out of date, the Reset
Runs dialog box displays. In this dialog box, you can reset the runs before they are launched.

7. Select Launch runs on local host and Number of jobs: 2 and click OK.
When the active run (impl_3) completes, the Implementation Completed dialog box opens.

8. Click Cancel to close the dialog box.
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9. Compare the Elapsed time for each run in the Design Runs window, as seen in the following figure.

Design Runs

a MName

impl_1

impl_2

=
=
il
4
»
«
=%

Strategy

Status

Vivado Implementation Defaults | ) Implemen. .. froute_ 1 Cormplete!
Performance_Explor TP
Flow_RunPhysOpt (Yivado Implementation 2... [route_design Complete!
Flow_RuntimeOptimized (vivado Implementation 2. froute_design Complete, Failed Timing!|constrs_2

aco Im) ntation 2014 ) Jroute_ rmplete!

e ! |

(1]

?— 0O =

Constraints  Elapsed WHS  THS  WHS

2 Tcl Console | © Messages | B Log | 2 Reports > Design Runs |

Figure 16: Implementation Results

¢ Notice that the impl_2 run, using the Performance_Explore strategy has passed timing with
positive slack (WNS), but also took the most time to complete.

e Only one other run passed timing, but with less positive slack.

RECOMMENDED: Reserve the Performance_Explore strategy for designs that have
challenging timing constraints. When timing is easily met, the Performance_Explore strategy
increases implementation times while providing no timing benefit.

Conclusion

In this lab, you learned how to define multiple implementation runs to employ different strategies to
resolve timing. You have seen how some strategies trade performance for results, and learned how to
use those strategies in a more challenging design.

This concludes Lab #1. If you plan to continue directly to Lab #2, keep the Vivado IDE open and close
the current project. If you do not plan to continue, you can exit the Vivado Design Suite.
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Lab 2: Using Incremental Compile

Introduction

Incremental Compile is an advanced design flow to use on designs that are nearing completion, where
small changes are required.

After resynthesizing a design with minor changes, the incremental compile flow can speed up
placement and routing by reusing results from a prior design iteration. This can help you preserve
timing closure while allowing you to quickly implement incremental changes to the design.

In this lab, you use the BFT example design that is included in the Vivado® Design Suite, to learn how to
use the incremental compile flow. Refer to the Vivado Design Suite User Guide: Implementation (UG904)
to learn more about Incremental Compile.

Step 1: Opening the Example Project

1. Start by loading Vivado IDE by doing one of the following:
e Launch the Vivado IDE from the icon on the Windows desktop.
e Type vivado from a command terminal.

2. From the Getting Started page, click Open Example Project.

Quick Start
Fat; . A % !
¥ =Ml
S i
Create New Project Open Project Open Example Project
Tasks

Manage IP Open Hardware Manager Xilinx Tcl Store

Figure 17: Open Example Design
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¢ Open Example Project

o

Create an Example Project
[
VlVADO This wizard will guide you through the creation of a new Vivado project from a predefined template.
HiLx Editions
To create a Vivade project you will specify the type of template project you would like to create. Next, you
will need to provide a name and a location for your project files and choose a default board.

To continue, click Next.

Figure 18: Open Example Project

3. Click Next in the Open Example Project screen.

4. Select the BFT (Small RTL project) design.

¢ Open Example Project
Select Project Template

9

Select one of the below predefined templates on which to base your new project '
Templates Description
Base MicroBlaze BFT
Base Zynq .
Small RTL project
Configurable Microblaze Design
CPU (HDL)

CPU (Synthesized)
Wavegen (HDL)

Figure 19: Select Example Project Screen
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5. Click Next.

6. In the Project Name screen, specify the following :
e Project name: project_bft_core_hdl
e Project location: <Project_Dir>

7. Click Next.

s

&

¢ Open Example Project
Project Name
Enter a name for your project and specify a directory where the project data files will be stored ‘

Project name: | project_bft_core_hdl
Project location: | C:/Data/Vivado_Tutorial D
Create project subdirectory

Project will be created at: C:/Data/Vivado_Tuterial/project_bft_core_hdl

< Back ” Hext = Finish

Figure 20: Project Name Screen
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8. In the Default Part screen, select the xc7k70tfbg484-2 part and click Next.

e

¢ Open Example Project

[e2]

Default Part
Choose a default Xilinx part for your project. This can be changed later. ‘
I/O Pin Block ) GTPE2 Gb Available LUT
[Tl Count RAMs DB PRI Transceivers Transceivers IOBs Elements
$ xc7k70tfbg676-2 2000 o |8 [0 Jaon

’ < Back ” Next > Einish

Cancel

9. The New Project Summary screen appears, displaying project details. When you have reviewed

these, click Finish.
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o]

¢ Open Example Project

New Project Summary

VIVADO!

Hx Editions (D' A new project named 'project_bft_core_hdl' will be created from the 'BFT' template.

(D The default part and product family for the new project:
Default Part: xc7k70tfhg484-2
Product: Kintex-7
Family: Kintex-7
Package: fbg484
Speed Grade: -2

& XILINX

ALL PROGRAMMABLE. To create the project, dick Finish

Figure 22: New Project Summary Screen

The Vivado IDE opens with the default view.

e project_bift_core_hdl - [C/Data/Nivado_Tuterial/preject_biy_core_hdl/project_bit_core_hdlxgpr] - Vivade 20151 o &3
Filk Edt Flow Tools Window Layout View Help
AR aeRb X P Pb Y &K LG | 0eful oy e Bk Ready
Flows Navigator “  Project Manager - projec_bit_core_hdl bt
a W Seurces S w L Project Summary o x
s aYme ] i
~ 3, w3t R : | Project Settings Edt
@ Froject Settings SN o { Fraject nami: oject_bit_care_hdl
e bt - anrr ) peepe
& Add Scurces {1 1 Consraints Project location:  C:/Deta/Vivedo_Tutorial/project_bit_core_hdl
¥ Longuege Templates £ 4= Simulation Sources (1 Product fomily:  Kintex-?
L P canaleg Frapect part: sckpUsfoata-2
4 Top module name: b4
7 Create Block Design Synthesis Imphementation %
‘i Statug: Not started Statue: Not started
e Hierarchy | Ubrories | Compie Order Messages: Mo errars or warnings Messages: No errors or wamings
+ Simulation & Sources | ¥ Tamgiates Part: WTHTDGH84-2 Part: HTITIHRGA84-2
Strateqy: Wiy hesis Defaults Strateqy:
?‘ S"nul.mm“ T Proparties; L Incremental compile:
& Run Simulation « + 5 X i
+ RTL Analysis = =
&) Elaboration Settings Tieming
[&* Open Elaborated Design B
4 Synthesis alact an ob)ect 1o 6o = =
@ Synthesis Settings
& Run Synthesis
oy
= iele i Design Runs - O x
@ mplementation Setlings
I Run Implementation “\ Narme Saratigy Status Constraints  Progress Elapsrd  WH
B 0o e = gyt 1 Vivedo Synthesis Defoulls (Vivado Syrthesis 2005) Mot storted constrs_1 (2]
: " = Impl_1 Vivado Imp Defaults (Vvada 2015) Kot started constrs_L %
# Program and Debug ]
) Mitstream Settings L]
%) Generate Bitstream | 3
@® Open Hardware Manager o
=
» 4 Tl
& Td Console | © Messages | Sl Log | 3 Reports. 1> Design Runs

Figure 23: Vivado IDE Showing project_bft_core_hdl Project Details
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Step 2: Compiling the Reference Design

1. From the Flow Navigator, select Run Implementation.

The Missing Synthesis Results dialog box opens, as shown in the figure below. The dialog box
appears because you are running implementation without first running synthesis. This lets you
choose to run synthesis at this time.

2. Click OK to launch synthesis first.

Synthesis runs, and implementation starts automatically when synthesis completes.

al‘;f_=. Missing Synthesis Results @

.e. There iz no netist available. OK to launch synthesis first? Implementation will automatically

= start when synthesis completes.

| OK | | Cancel

Figure 24: Missing Synthesis Results

After implementation finishes, the Implementation Complete dialog box opens.
3. Click Cancel to dismiss the dialog box.

In a project-based design, the Vivado Design Suite saves intermediate implementation results as
design checkpoints in the implementation runs directory. You will use one of the saved design
checkpoints from the implementation in the incremental compile flow.

O TIP: When you re-run implementation the previous results are deleted. Save the
intermediate implementation results to a new directory or create a new implementation run
for your incremental compile to preserve the reference implementation run directory.

4. In the Design Runs window, right click on impl_1 and select Open Run Directory from the popup
menu.

This opens the run directory in a file browser as seen in the figure below. The run directory contains

the routed checkpoint (bft_routed.dcp) to be used later for the incremental compile flow.
The location of the implementation run directory is a property of the run.

5. Get the location of the current run directory in the Tcl Console by typing:
get _property DIRECTORY [current_run]

This returns the path to the current run directory that contains the design checkpoint. You can use

this Tcl command, and the DIRECTORY property, to locate the DCP files needed for the incremental

compile flow.
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Mew folder

-~

m

Mame

\Z| bft_clock_utilization_placed.rpt

|Z] bft_control_sets_placed.rpt

\Z| bft_drc_routed.pb
bft_drc_routed.rpt

bft_io_placed.rpt

4. bft_opt.dcp

4. bft_placed.decp

bft_power_routed.rpt

bft_power_summary_routed.pb

4. bft_routed.decp

\Z| bft_timing_summary_routed.pb

|Z| bft_timing_summary_routed.rpt

\Z| bft_utilization_placed.pb

\Z| bft_utilization_placed.rpt

|#| gen_run.xml

| htrtxt

|| init_design.pb

Date modified

5/18/2014 8:10 AM
5/18/2014 8:10 AM
5/18/2014 8:11 AM
5/18/2014 811 AM
5/18/2014 8:10 AM
5/18/2014 8:09 AM
5/18/2014 8:10 AM
5/18/2014 8:11 AM
5/18/2014 811 AM
5/18/2014 8:11 AM
5/18/2014 8:11 AM
5/18/2014 811 AM
5/18/2014 8:10 AM
5/18/2014 8:10 AM
5/18/2014 8:07 AM
5/18/2014 8:07 AM
5/18/2014 8:08 AM

Lab 2:

Type

RPT File

RPT File

PB File

RPT File

RPT File

Vivade Checkpoin...
Vivade Checkpoin...
RPT File

PB File

Vivade Checkpoin...
PB File

RPT File

PB File

RPT File

XML Document
Text Decument

PB File

Using Incremental Compile

Size
13 KB
10 KB
1KB
73 KB
122 KB
499 KB
562 KB
11 KB
1KB
1,043 KB
1KB
49 KB
1KB
9KB
4 KB
1KB
3KB

Figure 25: Implementation Run Directory

=~ 0 @

-~

1

Step 3: Creating New Runs

In this step, you define new synthesis and implementation runs to preserve the results of the current
runs. Then you make changes to the design and rerun synthesis and implementation. If you do not

create new runs, Vivado overwrites the current results.

1. From the main menu, select Flow > Create Runs.

2. The Create New Runs wizard screen, shown in the following figure, prompts you to create new

Synthesis and/or Implementation runs. Select Both and click Next.

-

’

VIVADO'

Create New Runs

Create New Runs

HLx Editions

and launch them all at once.

What type runs do you want to create?

(7 synthesis

! Implementation

(@) Both

& XILINX

ALL PROGRAMMABLE.

To continue, click Next.

This wizard will guide you through the process of creating and launching multiple synthesis or/and
implementation runs. You can then apply different sets of command options, or strategies, to these runs

=

Cancel

FEinish
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3. The Configure Synthesis Runs screen opens. Accept the default run options by clicking Next.

4. The Configure Implementation Runs screen opens, as shown in the figure below. Enable the Make
Active check box, and click Next.

-

¢ Create New Runs

+ Name

- impl_2

Configure Implementation Runs
Create and configure one or more implementation runs using various parts, constraints, flows and strategies '

Create Implementation Runs
Synth Name
{# synth_2 (new)

=]

Constraints Set Fart Strategy Make Active

~ &= constrs_1 (active) - & xc7k70tfbg484-2 ~  Vivado Implementation Defaults (Vivado Implem... ~

Runs to create: 1

Figure 27: Configure Implementation Runs

5. From the Launch Options window, select Do not launch now and click Next.

6. Inthe Create New Runs Summary screen, click Finish to create the new runs.

The Design Runs window displays the new active runs in bold.

Design Runs — O 2 =
O\ Mame Strategy Status Progress Elapsed WHNS TNS WHS THS TPWS Descri
Z -+ synth_1 Vivado Synthesis Defaults (Vivado ... synth desngn Complehel 100% 00: 01 10 Vivado
B o nlementaton Defats (. Poutedesin Conplte) | = 100% | 00:03:53] .13/ 0.00] 0.07] 000 0.00lvaco
= synth_2 (active) Vivado Synthesis Defaults (Viv... Not started Vivad
P “-cp impl_2 (active)  Vivado Implementation Defaul... Not started 0% Vivad
14
W
4«
e
& 1 T 3
=) Td Console |  Messages | [ Log | (2 Reports' =» Design Runs
Figure 28: New Design Runs
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Step 4: Making Incremental Changes

In this step, you make minor changes to the RTL design sources. These changes necessitate

resynthesizing the netlist and re-implementing the design.

1. In the Hierarchy tab of the Sources window, double-click the top-level VHDL file, bft.vhdl, to
open the file in the Vivado IDE text editor, as shown in the following figure.

Sources — 0O w©® X

>gh B

M G pig
A oy =2

[+ Design Sources (1)

= ] bft - aBFT (bft.vhdl) (8)
arnd1 -round_1-aR1 (ro
arnd2 -round_2 - aR.2
arnd3 -round_3 -aR3
arnd4 - round_4 - aR4 |_:
ingressLoop.ingressFifo - FifoBuffer |
«8 egressLoop.egressFifo - FifoBuffer (FifoBu
(-1 Constraints (2)

[+ Simulation Sources (1)

' T v O
Hierarchy | Libraries | Compile Crder
£ Sources | ' Templates
Source File Properties —_ O =
« >EE
il bft.vhdl
Location: C:/Data/Vivado_Tutorial fproject_b: =
Type: VHDL M) 3
Library: work E] b
Size: 10.9KE
Modified: Monday 06/03/13 12:12:58 PM
Copied to: <Project Directory =fproject_bft_o -
< | [T =

General | Properties

T Project Summary X | &h bftwhdl = x
Eﬁ C:/Data/Vivado_Tutorial fproject_bft_core_hdl/project_bft_core_hdl.srcsfsources_1fimportshdl/bft. vhdl

28

29 library IEEE;

30use IEEE.STD LOGIC 1164.all;
31use IEEE.STD LOGIC ARTTH.all;
32use IEEE.STD LOGIC SIGNED.=zll;
55

34 library bftLib;

35 use bftLib.bftPackage.all;

36

37 entity bft is

38 port |

&30 wbClk, bftClk, reset : in std legic;

40 wbDataForInput :in std logic;

41 wbWriteQut: in std legic;

42 wbDataForOutput : out std logic;

43 wbInputData : in std logic wector (31 downto 0);
44 wbCutputData : out 2td logic vector (31 downtoc 0);
45 error @ buffer std logic

48 N

47

48 attribute fsm encoding :string;
49 attribute fsm encoding of bift :
50 end entity bft;

entity is "one-hot" ;

al

52 architecture aBFT of bft is

55

54 component FifoBuffer

55 port

13 din: IN std logic VECTOR(31 downto 0);
57 rd ,lls TH std lamic-

4| 1

O 2

m

Figure 29: BFT VHDL File

2. Go to line 45 of the bft.vhdl file and change the error port from an output to a buffer, as follows:

error : buffer std logic
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3. Go to line 331 of the bft.vhdl file and modify the VHDL code, as follows:

From

To

-- enable the read fifo
process (fifoSelect)
begin

readEgressFifo <=
end process;

fifoSelect;

-- enable the read fifo
process (fifoSelect, error)
begin

if (error = “0”) then

readeEgressFifo <=

fifoSelect;
else

readeEgressFifo <=
"0%);
end if;
end process;

(others

The results should look like the following

figure.

319
o 320

321
3&, 322
323
=324
4:‘] 325
¥ 326
II,-II,- 327
328 end if;
329 end process;
330

331 -- enakble
332 process (fifoSelect,
333 begin
334 if
335

336 else
337 readEgressFifo <=
338 end if;

339 end process;

end

w

end
end case;
end

if;

the read fi

{error = "0") t©
readEgressFifo

343 end architecture aBFT
344

% Project Summary X | G Device ¥ | wh bftvhdl * x
m C:/Data/Vivado_Tutorial fproject_bft_core_hdlfproject_bft_core_hdl.sresfsources_ 1 fimportsfhdlbft

caser

if {egressFifoEmpty(7) = "1') then
demuxState <= stall;
wbDataForlutput <= "0";

wblutputData <=
if;

when others =>

error)

hen
<= fifoSelect;

{others =» "0');

O

s

{others =» "0");

om

1

Figure 30: Modified VHDL Code
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4. Save the changes by clicking the Save File =4 button in the sidebar menu of the text editor.

As you can see in the following figure, changing the design source files also changes the run status
for finished runs from Complete to Out-of-date.

Design Runs — O > =
Q Strategy Status Progress Elapsed WNS TS WHS  THS TPWS Des
= =1 4 Vivado Synthesis Defaults (Vivado ... Synthesis Out-of-date 1 100%  00:01:10 Viva
=25
% : i mplementation Out-of-date [l 100%:  00:03:13 0.13  0.00 0.07 0.00 0.00 Viva
IF "
= - synth_2 (scbvo I I 7

§> el impl_2 (active) Viva
4
|

&
e (] »

=) Td Console |  Messages | [d Log | |2 Reports-. 3 Design Runs
Figure 31: Design Runs Out-of-Date

5. In the Flow Navigator, click Run Synthesis to synthesize the updated netlist for the design using the
active run, synth_2.

6. When the Synthesis Completed dialog box opens, click Cancel to close the dialog box.

Step 5: Running Incremental Compile

You updated the design with a few minor changes, necessitating re-synthesis. You could run
implementation on the new netlist, to place and route the design and work to meet the timing
requirements. However, with only minor changes between this iteration and the last, the incremental
compile flow lets you reuse the bulk of your prior placement and routing efforts. This can greatly reduce
the time it takes to meet timing on design iterations.

For more information, refer to this link in the Vivado Design Suite User Guide: Implementation (UG904).

Start by defining the design checkpoint (DCP) file to use as the reference design for the incremental
compile flow. This is the design from which the Vivado Design Suite will draw placement and routing
data.

1. In the Design Runs window, right-click the impl_2 run and select Set Incremental Compile from
the popup menu.

The Set Incremental Compile dialog box opens, as shown in Figure 32.

2. Click the Browse ] button in the Set Incremental Compile dialog box, and browse to the
./project_bft_core_hdl.runs/impl_1 directory.
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3. Select bft_routed.dcp as the incremental compile checkpoint.

al‘;f_=. Set Incremental Compile @

':0:' Enable/disable incremental compiling by choosing or dearing a chedkpoint file.

Use checkpoint: | vivado_Tutorial/project_bft_core_hdl/project_bft_core_hdl.runs/impl_1/bft_routed.dcp| I:I

[ oK ” Cancel |

Figure 32: Set Incremental Compile

4. Click OK.
This is stored in the INCREMENTAL_CHECKPOINT property of the selected run. Setting this

property tells the Vivado Design Suite to run the incremental compile flow during implementation.

5. You can check this property on the current run using the following Tcl command:
get _property INCREMENTAL_ CHECKPOINT [current_run]

This returns the full path to the bft_routed.dcp checkpoint.

O TIP: To disable incremental compile for the current run, clear the
INCREMENTAL_CHECKPOINT property. This can be done using the Set Incremental
Compile dialog box, or by editing the property directly through the Properties window of

the design run, or through the reset_property command.

6. From the Flow Navigator, select Run Implementation.

This runs implementation on the current run, using the bft_routed.dcp file as the reference
design for the incremental compile flow. When the run is finished, the Implementation Completed
dialog box opens.

7. Select Open Implemented Design and click OK.
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As shown in the following figure, the Design Runs window shows that the elapsed time for
implementation run impl_2 is the same as for impl_1 because of the incremental compile flow.

Note: This is an extremely small design. The advantages of the incremental compile flow are greater

with larger, more complex designs.

Design Funs

Q| Mame Constraints Skatus Elapsed WS THS WWHS THS
E =4l synth_1 constrs_1 Synthesis Out-of-dake o0:01:11

% ¢ eadimpl 1 constrs_1 Implementation Out-of-date 00:01:25 0,810 0,000  0.053 0.000
MR synth_2 (active) constrs_1 synth_design Complete! 00:01:03

3> ~impl_2 {ackive)

4 I

B Log

42 Package Fins

5 Tel Consale | () Messages |2 Reports

Figure 33: Elapsed Time for Incremental Compile

=» Design Runs

& Timing

TRWS

Description
Yivado Synthesis Defaults
0,000 Yivado Implementation Defauls
¥ivado Synthesis Defaults

000125 0.979] 0.000] 0.053] 0.000] 0.000wvado 1mplementation Defaults |

8. Select the Reports tab in the Results Window area and double-click the Incremental Reuse Report
in the Place Design section, as shown in the following figure.

Reports

Marne
--F'n:nwer Opt Design (power_opk_design)
[=-Place Design (place_design)
- [ Yivado Implermentation Log
-2 Pre-Placement Incremental Reus, .,
-2 IO Repork
- [ Ukilization Repart
-2 Contral Sets Repart
- & Incremental Reuse Report

ik B4 P

Modified Size

102915 4:38 PM
1029015 4:37 PM
102915 4:38 PM
102915 4:35 PM
102915 4:38 PM
1029015 4:38 PM

GUI Repart

31.6 KB
2.6 kB
126.3 KB
9.4 KB
9.5 KB
2.6 kKB

Timing Surmmary Fepork

[+~ Post-Place Power Opk Design (posk_place_power_opk_design)
[t Post-Place Phys Opt Design (phys_opt_desian)

[+ Foute Design (rouke design)

12 Tdl Consale

Ed Loge, S Reports | 50 Package Pins | ¥ Desion Runs | (3 Timin

' Messages
Figure 34: Reports Window

The Incremental Reuse Report opens in the Vivado IDE text editor, as displayed in Figure 35. This
report shows the percentage of reused Cells, Ports, and Nets. A higher percentage indicates more
effective reuse of placement and routing from the incremental checkpoint.

Implementation www.xilinx.com

UG986 (v2016.4) November 30, 2016

33

l Send Feedback I


http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG986&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Implementation&releaseVersion=2016.4&docPage=33

& XILINX

ALL PROGRAMMABLE. Lab 2: Using Incremental Compile

I Project Summary X | @ Device X | @ bft.vhdl X | £ Incremental Reuse Report - impl_2  x 7R Tox
Ci/DatafVivado_Tutorial/Tutorial_Created_Datafproject_bft_core_hdlfproject_bft_core_hdl.runsfimpl_2ibft_incremental_reuse_placed.rpt Read-only
1 Copyright 1986-2015 ¥ilinx, Inc. 411 Rights Reserwved. o
2 e —————————————————————————————————————
31 Tool Version : Viwado w.2015.4 (winf4) Build 1395460 Wed Oct 2§ 17:35:22 MDT Z015

.| 41| Date : Thu Oct 29 16:35:09 2015

_' 5| Host i x8jengvmzl0036 running 64-bit Serwvice Pack 1 (build 760l)

Ej 6 | Command : report_incremental reuse -file bft incremental reuse_placed.rpt (Using checkpoint C:/Data/|
71 Desigm : bft
i | Device i XoTR70C
= gy gy

10
11 Incremental Beuse Suumary

"§J 1z

- 13 1. Netlist Similarity Summary

V(14 -—-
15
16+ - + + t-— +
171 Type | Count | Total | Percentage |
15+ - + + t-— +
19| Matched Cells | 3609 | 3641 | 99,12 |
20| Matched Ports | 71 | loo.00 | E
2zl | Matched Nets | 6271 | BEZ85 | 99.72 |
ZZ24 - + + t-— +
B3
Z4
25 2. Implementation Reuse Summary
zZ6 -—-
27
28+ m e + + + +
291 Type | Count | Total | Percentage |
30+ e + + + +
31 | Reused Cells | 3604 | 364l | 95.98 |
32 | Reused Ports | 7L 711 100.00 |
33 | Reused Nets | 5176 | 5224 | 99.08 |
34| | | | |
35 | Non-Reused Cells | 371 364l | L.ol |
36 Hew | 32 1 364l | 0.87 |
371 Digcarded illegal placement due to netlist changes | 51 3641 | 0.13 |
38 | Fully Reused nets | 5148 | 5224 | 98,54 |
39| Partially reused nets | 28 | 5224 | 0.53 |
40 | Non-Feused nets | 48 | 5zZa4d | 0.91 |
41 + ST m e mm t t t t
42 i

4 T 3

Figure 35: Incremental Reuse Report

In the report, fully reused nets indicate that the entire routing of the nets is reused from the reference
design. Partially reused nets indicate that some of the routing of the nets reuses routing from the
reference design. Some segments re-route due to changed cells, changed cell placements, or both.
Non-reused nets indicate that the net in the current design was not matched in the reference design.

Conclusion

This concludes Lab #2. You can close the current project and exit the Vivado IDE.

In this lab, you learned how to run the Incremental Compile flow, using a checkpoint from a previously
implemented design. You also examined the similarity between a reference design checkpoint and the
current design by examining the Incremental Reuse Report.

Implementation www.xilinx.com 34
UG986 (v2016.4) November 30, 2016 Send Feedback


http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG986&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Implementation&releaseVersion=2016.4&docPage=34

& XILINX

ALL PROGRAMMABLE,

Lab 3: Manual and Directed Routing

Introduction

In this lab, you learn how to use the Vivado® IDE to assign routing to nets for precisely controlling the

timing of a critical portion of the design.

e You will use the BFT HDL example design that is included in the Vivado Design Suite.

e To illustrate the manual routing feature, you will precisely control the skew within the output

bus of the design, wbOutputData.

Step 1: Opening the Example Project

1. Start by loading Vivado IDE by doing one of the following:
e Launch the Vivado IDE from the icon on the Windows desktop.
e Type vivado from a command terminal.

2. From the Getting Started page, click Open Example Project.

Quick Start
A7 Y. .
=
L § &=
Create Mew Project Open Project Open Example Project
Tasks

, &

Manage IP Open Hardware Manager Xilinx Tcl Store

&l

Figure 36: Open Example Design
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¢ Open Example Project | &3 |
Create an Example Project
Vl\/ADO‘ This wizard will guide you through the creation of a new Vivado project from a predefined template.
HLx Editions

To create a Vivado project you will specify the type of template project you would like to create. Next, you
will need to provide a name and a location for your project files and choose a default board.

To continue, click Next.

Figure 37: Open Example Project

3. Click Next in the Open Example Project window.
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4. Select the BFT (Small RTL project) design.

e

¢ Open Example Project [ ]
Select Project Template
Select one of the below predefined templates on which to base your new project ‘
Templates Description
Base MicroBlaze BFT
Base Zyng .
Small RTL project
Configurable Microblaze Design
CPU (HDL)

CPU (Synthesized)
Wavegen (HDL)

me ] e

Figure 38: Open Example Project, Select Example Project Screen
5. Specify the following:
0 Project name: project_bft_core

0 Project location: <Project_Dir>
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6. Click Next.
¢ Open Example Project | X |
Project Name
Enter a name for your project and specify a directory where the project data files will be stored '
Project name: | project_bft_core
Project location: | C:/Data/Vivado_Tutorial E]

Create project subdirectory

Project will be created at: C:/Data/Vivado_Tutorial/project_bft_core

’ < Back ” Next = Finish

Figure 39: Project Name Screen

7. Select the xc7k70tfbg484-2 as your Default Part.
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8. Click Next.
¢ Open Example Project _Eé_i
Default Part
Choose a default Xilink part for your project. This can be changed later. '
YO Pin Block GTPE2 Gb Avallable LuT
i Count RAMS i FipFIOPS  rransceivers Transceivers 10Bs Elements
[ xeTkrotbge76-2 676 i35 a0 ssoo0 Jo 8 [300 41000 |
‘ fil '
i <Back || Wet> | Finish Cancel

Figure 40: Default Part Screen

9. Click Finish.

# Open Example Project (55

New Project Summary

VIVADO!

MLt Edaans (A new project namied ‘project_bit_core’ will be created from the "BFT" template.

() The default part and product famaly for the new project:
Default Fart: xc7k70tfbga84-2
Product: Kintex-7
Family: Kintex-7
Package: fbgd84
Speed Grade: -2

& XILINX

R PRGG AR To create the project, click Finish

7 <fiack | MNet> | fFinigh | | Cancel |

Figure 41: New Project Summary Screen
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The Vivado IDE opens with the default view, as shown in the following figure.

. project it cone - [C/Data/Vivado_Tutorial/prcject_bit_core/project_bit_corexpr] - Vivads 20142 [E=m e |
Fle Edt Flow Tools Window Loyout Vew Help Q- 5
Ao BRhX S0Py 6K LG Hoemiuo - e |B Ready
Flow Naragator *® Project Mamager (roject bft_cere L
o e Sources -oex |8 * =N
aZmwa hE &
4 Project Hanager = - — [FIRrY
i+ Desgn Sources (1 -
i it Bl - BT (ot o
Corstiants (2
Smulaton Sources (|
& Implementation S
Status: = Mol strted Staba: S Mot storted
Messages: o erTors o marTIgs. e o errirs o warrngs
Part: wsRePOnfbgasa.2 Part: wreOtfbgase.2
T Stategr:  Vivado Seifwss Defaity Stategy: ey [moterrmntaten Delaty
@ Serudabon Settngs "“:"'d"" ""“"_‘ Comople Crder Consgrants: corntrs 7 Consiraints: ot 2
2 Faun Semudation da Seurces | § Tonpleles | Incrementsl Compde: tins
Proprstes. -0 x
4 RTL Analysis DR Vielations #  Timing Ed
5 + 5 &
{5 Open Elsborated Dessgn
'
* Syhess
1F Simithess Seiengs
& fans ttration % Power = |
+ [ Open Synthested D -
tkraton rformaton & not avalable because it hasr't been Power
@ Implementaton
) beplementation Settings
[ Foun bmplementaton
B Cven Irplemerted D
Desgn furs -0 %
A Proomm and Dy O, | Hame Constants WIS TG WHG  THG  TPWS  FaledRoutes WT PP BRAM DS st Oopoed  Stans  Progress stra
B Betutrnam Settrge = e e 1 eoesirs_2 Ht started % v
¥ Generasr Bitstrram = =gl l constrs_2 ot started 0% Vvl
2 Open Hardware Marager >
H
»
L]
=
|, . . — il v
[ Td Console | Messages | Liog | X Reports | T Design Runs

Figure 42: BFT Core Project Summary
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Step 2: Performing Place and Route on the Design

1. In the Flow Navigator, click Run Implementation.

The Missing Synthesis Results dialog box opens to inform you that there is no synthesized netlist to
implement, and prompts you to start synthesis first.

e

-

ﬁ“_ Missing Synthesis Results @

[0] There is no netlist available. OK to launch synthesis first? Implementation will automatically
= start when synthesis completes.

| 0K | | Cancel

Figure 43: Missing Synthesis Results
2. Click OK to launch synthesis first.

Implementation automatically starts after synthesis completes, and the Implementation Completed
dialog box opens when complete, as shown in the following figure.

Implementation Completed @

I:o:l Implementation successfully completed.

Mext

@ Dpen Implemented Desigre

Generate Bitstream

View Reports

Don't show this dialog again

Ok I | Cancel

Figure 44: Implementation Completed
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3. In the Implementation Completed dialog box, select Open Implemented Design and click OK.

The Device window opens, displaying the placement results.

4. Click the Routing Resources button &l to view the detailed routing resources in the Device
window.

T, Project Summary X | &5 Device X O =

Figure 45: Device View
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Step 3: Analyzing Output Bus Timing

IMPORTANT: The tutorial design has an output data bus, wbOutputData, which feeds
external logic. Your objective is to precisely control timing skew by manually routing the nets
of this bus.

You can use the Report Datasheet command to analyze the current timing of members of the output
bus, wbOutputData. The Report Datasheet command lets you analyze the timing of a group of ports
with respect to a specific reference port.

1. From the main menu, select Tools > Timing > Report Datasheet.

2. Select the Groups tab in the Report Datasheet dialog box, as seen in the following figure, and enter
the following:

o Reference: [get_ports {wbOutputData[0]}]
0 Ports: [get_ports {wbOutputData[*]}]

#- Report Datasheet 23
Create a datasheet report for the current design. The datasheet has the timing
characteristics of a design at the IO pads. ‘

Options” Groups | Timer Settings

1. Reference | [get_ports {wbOutputData[0]}]

aja

Ports |[get_ports {wbOutputData[*]}]

Command: |latasheet -group [get_ports {wbOutputData[0] wbOutputData[*]}] -name timing_1
| Open in a new tab

Open in Timing Analysis layout

[ oK ] | Cancel

Figure 46: Report Datasheet

3. Click OK.
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In this case, you are examining the timing at the ports carrying the wbOutputData bus, relative to
the first bit of the bus, wobOutputData[0]. This allows you to quickly determine the relative timing
differences between the different bits of the bus.

Click the Maximize button &' to maximize the Timing - Datasheet window and expand the

results.

Select the Max/Min Delays for Groups > Clocked by wbClk > wbOutputData[0] section, as seen in

the following figure.

You can see from the report that the timing skew across the wbOutputData bus varies by almost

700 ps. The goal is to minimize the skew across the bus to less than 100 ps.

Timing - Datasheet - timing_1

AZTSsEsr?
----- General Information
----- Input Ports Setup/Hold
----- Output Ports Clock-to-out
----- Setup between Clocks
—I-Setup/Hold for Input Buses
—|-Clocked by whClk
“-abInputData
—I-Max/Min Delays for Output
—I-Clocked by whClk
“whOutputData
=I-Max/Min Delays for Groups

= -Clocked by whClk

4 I

Timing Summary - impl_1 X | Datasheet - timing_1 x

=

4

[

Source
(7N
&

o wbOutputData
< wbOutputData
< wbOutputData[27]
< wbOutputData[26]
< whOutputData[25]

< wbOutputData[0]
< wbOutputData[31
< wbOutputData[30
[29
[28

1
1
1
1

< whOutputData[24]
< whOutputData[23]
< wbOutputData[22]
< wbOutputData[21]
< wbOutputData[20]
< wbOutputData[19]
< wbOutputData[18]
< wbOutputData[17]
< wbOutputData[16]
< whOutputData[15]
< whOutputData[14]
< wbOutputData[13]
< wbOutputData[12]
< wbOutputData[11]
o wbOutputData[10]
< wbOutputData[9]
< wbOutputData[8]
< wbOutputData[7]
< whOutputData[6]
<4 whOutputData[5]
< whOutputData[4]
< wbOutputData[3]
< wbOutputData[2]
< wbOutputData[1]
“ wbOutputData[0]
Worst Case Summary

Bus Skew: 0.677 ns
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Edge
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7. Click the hyperlink for the Setup time of the source wbOutputData[31].
This highlights the path in the Device view window that is currently open.

Note: Make sure that the Autofit Selection & is highlighted in the Device window so you can see the
entire path, as shown in the following figure.

T Project Summary X | 5 Device x 7 X

a7 |B R R

,E‘n

& 1€

-

b

5 B

T
[

¢ ]

Timing - Datasheet - timing_1 — O v ®
QT e a2 MaxMin Delays fo - Clocked by whCk - wbi
e = 4 ax/Min Delays for Groups - Clof y whClk - wbOutputData[0]
= Sempfﬂnld for Input Ports A ¢ Setup  Setup Process d Hold Hold Process  Source Offset
MaxMin Delays for Output Ports \:.r‘ SOEE SEtp) Edge Corner o Edge  Corner to Center
Setup between Clocks =
SEtLIEfHDld for Input Buses -3 wbOutputData[0] 8,358 Rise sLow 3.603 Rise FAST 0.000 -
" Clocked by whCk | whoutputDatalsl | JRise | [Rise | 0.323
£ whirpuData <7l whOutputData[30] 7.939Rise  SLOW 3.367Rise  FAST 0.420
Maxfl:‘lln Delays for Output Buses E <3 wbOutputData[29] 7.984 Rise SLOW 3.382 Rise FAST 0.374
[ Clocked by whClk -3 wbOutputData[25] 8.027 Rise sLow 3.403 Rise FAST 0.331
5 whOutputData <3 whOutputData[27] 7.901 Rise SLOW 3.342 Rise FAST 0.458
iy Mﬂ)(,;';’“l‘l Delays for Groups -3 wbOutputData[26] 7.915 Rise sLow 3,336 Rise FAST 0444 -
=I5 Clocked by wbClk -
: m o Bus Skew: 0.478 ns

[ Td Console | (" Messages | (4] Log | |5 Reports | 3 Design Runs', (3 Timing
Figure 48: Detailed Routing View

8. In the Device window, right click on the highlighted path and select Schematic from the popup
menu.

This displays the schematic for the selected output data bus, as shown in Figure 49. From the
schematic, you can see that the output port is directly driven from a register through an output
buffer (OBUF).

If you can consistently control the placement of the register with respect to the output pins on the
bus and control the routing between registers and the outputs, you can minimize skew between the
members of the output bus.
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wbOutputData_reg[31]
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Figure 49: Schematic View of Output Path

9. Change to the Device window.

To better visualize the placement of the registers and outputs, you can use the mark_objects
command to mark them in the Device view.
10. From the Tcl Console, type the following commands:

mark_objects -color blue [get ports wbOutputData[*]]
mark_objects -color red [get_cells wbOutputData reg[*]]

Blue diamond markers show on the output ports, and red diamond markers show on the registers
feeding the outputs, as seen in the following figure.

. Project Summary X | § Dewice X | 7] Schematic X Prox

.
&

]
o)
[

%

D3k IR P S

Figure 50: Marked Routes

Zooming out on the Device window displays a picture similar to Figure 50.

The outputs marked in blue are spread out along two banks on the left side starting with
wbOutputData[0] (on the bottom) and ending with wbOutputData[31] (at the top), while the
output registers marked in red are clustered close together on the right.
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To look at all of the routing from the registers to the outputs, you can use the
highlight_objects Tcl command to highlight the nets.

11. Type the following command at the Tcl prompt:

highlight objects -color yellow [get _nets -of [get pins -of [get cells\
wbOutputData reg[*]] -filter DIRECTION==0UT]]

This highlights all the nets connected to the output pins of the wbOutputData_reg[*] registers
as shown in Figure 51.

In the Device window, you can see that there are various routing distances between the clustered
output registers and the distributed outputs pads of the bus. Consistently placing the output
registers in the slices next to each output port eliminates a majority of the variability in the clock-to-
out delay of the wbOutputData bus.

T Project Summary ¥ | G Device X | ¥7] Schematic X Frox

& e E .
Sieeh

EEE
=

Figure 51: Highlighted Routes

12. Click the Unhighlight All button B and the Unmark All button % in the main toolbar menu.
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Step 4: Improving Bus Timing through Placement

To improve the timing of the wbOutputData bus you will place the output registers closer to their
respective output pads, then rerun timing to look for any improvement. To place the output registers,
you will identify potential placement sites, and then use a sequence of Tcl commands, or a Tcl script, to
place the cells and reroute the connections.

O RECOMMENDED: Use a series of Tcl commands to place the output registers in the slices next to the
wbOutPutData bus output pads.

1. In the Device window click to disable Routing Resources . and make sure AutoFit Selection /&
is still enabled on the sidebar menu.

This lets you see placed objects more clearly in the Device window, without the added details of the
routing.

2. Select the wbOutputData ports placed on the I/O blocks with the following Tcl command:
select_objects [get_ports wbOutputData*]

The Device window will show the selected ports highlighted in white, and zoom to fit the selection.
The view should be similar to Figure 52. By examining the device resources around the selected
ports, you can identify a range of placement Sites for the output registers.
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Figure 52: Selected wbOutputData Ports
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3. Zoom into the Device window around the bottom selected output ports. The following figure shows

the results.

% Project Summary X | G Device X | #7] Schematic X

Port: whOutputData[0]
Direction: Output

Met: whOutputData[0]
BEL: PAD

Site: ¥21 (fixed)

BEL: "AFF'

Type: REG_INIT
Murnber of pins: 5
MNumber of input pins: 4
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Mumber of output pins: 1
Site: SLICE_X0Y36
Tile: CLBLL_L_X2¥36

Site type: I0_L7P_T1_13 N
2 Tile: LIOB33_X0Y35 £

Package pin: Y21

1/0 Bank: /'O Bank 13

4 I, 3

Figure 53: wbOutputData[0] Placement Details

The bottom ports are the lowest bits of the output bus, starting with wbOutputData[0].

As seen in Figure 53, this port is placed on Package Pin Y21. Over to the right, where the Slice logic
contains the device resources needed to place the output registers, the Slice coordinates are X0Y36.
You will use that location as the starting placement for the 32 output registers,
wbOutputData reg[31:0].

By scrolling or panning in the Device window, you can visually confirm that the highest output data
port, woOutputData[31], is placed on Package Pin K22, and the registers to the right are in Slice
X0Y67.

Now that you have identified the placement resources needed for the output registers, you must
make sure they are available for placing the cells. You will do this by quickly unplacing the Slices to
clear any currently placed logic.

Unplace any cells currently assigned to the range of slices needed for the output registers,
SLICE_X0Y36 to SLICE_XO0Y67, with the following Tcl command:

for {set i 0} {$i<32} {incr i} {
unplace_cell [get _cells -of [get_sites SLICE_XOY[expr 36 + $i]l]
}
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This command uses a FOR loop with an index counter (i) and a Tcl expression (36 + $i) to get
and unplace any cells found in the specified range of Slices. For more information on FOR loops and
other scripting suggestions, refer to the Vivado Design Suite User Guide: Using Tcl Scripting (UG894).

TIP: If there are no cells placed within the specified slices, you will see warning messages that
nothing has been unplaced. You can safely ignore these messages.

With the Slices cleared of any current logic cells, the needed resources are available for placing the
output registers. After placing those, you will also need to replace any logic that was unplaced in the
last step.

Place the output registers, wbOutputData_reg[31:0], in the specified Slice range with the
following command:

for {set i1 0} {$i<32} {incr i1} {
place_cell wbOutputData_reg[$i] SLICE_XOY[expr 36 + $i]/AFF
}

Now, place any remaining unplaced cells with the following command:
place_design
Note: The Vivado placer works incrementally on a partially placed design.
As a precaution, unroute any nets connected to the output register cells,
wbOutputData_reg[31:0], using the following Tcl command:
route_design -unroute -nets [get nets -of [get cells wbOutputData reg[*]111

Then route any currently unrouted nets in the design:

route_design
Note: The Vivado router works incrementally on a partially routed design.

Analyze the route status of the current design to ensure that there are no routing conflicts:

report_route_status

Click the Routing Resources button 4l to view the detailed routing resources in the Device
window.

Mark the output ports and registers again, and re-highlight the routing between them using the
following Tcl commands:

mark_objects -color blue [get_ports wbOutputData[*]]

mark_objects -color red [get_cells wbOutputData_reg[*]]
highlight_objects -color yellow [get_nets -of [get_pins -of [get_cells\
wbOutputData reg[*]] -filter DIRECTION==0UT]]

TIP: Because you have entered these commands before, you can copy them from the
Journal file (vivado . jou) to avoid typing them again.
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12. In the Device window, zoom into some of the marked output ports.

13. Select the nets connecting to them.

O TIP: You can also select the nets in the Netlist window, and they will be cross-selected in

the Device window.

In the Device window, as seen in Figure 54, you can see that all output registers are now placed

equidistant from their associated outputs, and the routing path is very similar for all the nets from
output register to output. This results in clock-to-out times that are closely matched between the
outputs.
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o
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off
off
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toBft[15] (15)

I whInputData (32)

whInputData_IBUF (32)
whOutputData (32

-all whOutputData_OBUF (32)

L
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o
ol

I wbOutputData_OBUF[S]
oI whOutputData_OBUF[5]
o] whOutputData_OBUF[7]
oI whOutputData_OBUF[8]
ol whOutputData_OBUF[5]
ol wbOutputData_OBUF[10]
ol whOutputData_OBUF[11]
ol whOutputData_OBUF[12]
oI whOutputData_OBUF[13]
ol wbOutputData_OBUF[14]
oI whOutputData_OBUF[15]
oI whOutputData_OBUF[18]
oI whOutputData_OBUF[17]
ol whOutputData_OBUF[18]
ol wbOutputData_OBUF[19]
o whOutputData_OBUF[20]
ol whOutputData_OBUF[21]
oI whOutputData_OBUF[22]
ol whOutputData_OBUF[23]
ol whOutputData_OBUF[24]

w [ sah i dmudhiata ORLIEME]

& Sources., 3] Netlist

m
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Figure 54: Improved Placement and Routing

14. Run the Tools > Timing > Report Datasheet command again.

The Report Datasheet dialog box is populated with settings from the last time you ran it:

0 Reference: [get_ports {wbOutputData[0]}]

0 Ports: [get_ports {wbOutputData[*]}]
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15. In the Report Datasheet results, select the Max/Min Delays for Groups > Clocked by wbClk >

wbOutputData[0] section.

Examining the results shown in Figure 55, the timing skew is closely matched within both the lower
bits, wbOutputData[0-13], and the upper bits, wbOutputData[14-31], of the output bus.
While the overall skew is reduced, it is still over 200 ps between the upper and lower bits.

With the improved placement, the skew is now a result of the output ports and registers spanning
two clock regions, XOY0 and X0Y1, which introduces clock network skew. Looking at the
wbOutputData bus, notice that the Setup delay is greater on the lower bits than it is on the upper
bits. To reduce the skew, add delay to the upper bits.

You can eliminate some of the skew using a BUFMR/BUFR combination instead of a BUFG, to clock
the output registers. However, for this tutorial, you will use manual routing to add delay from the
output registers clocked by the BUFG to the output pins for the upper bits, wbOutputData[14-
31], to further reduce the clock-to-out variability within the bus.

Timing - Datasheet - timing_2 — O a =
AT EEs 4 Max/Min Delays for Groups - Clocked by whClk - wbOutputData[0]
""" £ General Information P a = Setup  Setup Process Hold Hold Process  Source Offset
|2 SetupfHold for Input Ports ) SIS Setup Edge Corner Hold Edge  Corner to Center
""" 51 MaxMin Delays for Output Ports 3 whOutputData[0] 7.011Rise  SLOW 3.303Rise  FAST 0.000
""" ) Setup between Clocks «J whOutputData[0] 7.011Rise  SLOW 3.303Rise  FAST 0.000
B Setup/Hold for Input Buses 3 whOutputData[1] 7.878 Rise sLow 3.271Rise  FAST 0.033
EHE Clocked by whCk « whOutputData[2] 7.875Rise  SLOW 3.269Rise  FAST 0.035
""" 1 whInputData < whOutputData[3] 7.874Rise  SLOW 3.267Rise  FAST 0.037
E'""'T Max/Min Delays for Cutput Buses < whOutputData[4] 7.858 Rise sLow 3.251Rise  FAST 0.043
B+ Clocked by wbCk 3 whOutputData[s] 7.919 Rise  SLOW 3.311Rise  FAST 0.008
""" £ wbOutputData 3 whOutputData[s] 7.915Rise  SLOW 3.306 Rise  FAST 0.004
B Max/Min Delays for Groups 3 whOutputData[7] 7.881Rise  SLOW 3.274Rise  FAST 0.030
=+ Clocked by wbCk 3 whOutputData[s] 7.886 Riss  SLOW 3.278Rise  FAST 0.025
""" ERnbou 3 whOutputData[a] 7.914Rise  SLOW 3.306Rise  FAST 0.004
3 whOutputData[10] 7.905Rise  SLOW 3.297Rise  FAST 0.006
3 whOutputData[11] 7.897 Rise  SLOW 3290 Rise  FAST 0.014
3 whOutputData[17] 7.891Rise  SLOW 3.284Rise  FAST 0.019
(j U\bOuu:utDaIB[B] 7.942Rise  SLOW 3.335Rise  FAST 0.032
| ¢ whOutputData[14] | JRise | _--_
(} mbOuh:utDaiB[lS] 7.723 Rise SLOW 3.235 Rise D 138
43 whOutputData[16] 7.718Rise  SLOW 3.231 Rise FAST 0.193
3 whOutputData[17] 7.681Rise  SLOW 3.133Rise  FAST 0.230
3 whOutputData[ 18] 7.678Rise  SLOW 3.191Rise  FAST 0.233
3 whOutputData[19] 7.70Rse  SLOW 3.242Rise  FAST 0.181
3 whOutputData[20] 7.723Ris= SLOW 3236 Rise  FAST 0.188
J whOutputData[21] 7.691Rise  SLOW 3.203Rise  FAST 0.220
3 whOutputData[22] 7.687Rise  SLOW 3200 Rise  FAST 0.224
3 whOutputData[23] 7.701Rise  SLOW 3.214Rise  FAST 0.210
3 whOutputData[24] 7.695Rise  SLOW 3.208Rise  FAST 0.215
< whOutputData[25] 7.694Rise  SLOW 3.208Rise  FAST 0.217
3 whOutputData[26] 7.683 Rise  SLOW 3.201Rise  FAST 0.223
43 whOutputData[27] 7.715Rise  SLOW 3.223Rise  FAST 0.195
3 whOutputData[28] 7.707Rise  SLOW 3.222Rise  FAST 0.204
3 whOutputData[2] 7.705Rise  SLOW 3.221Rise  FAST 0.205
3 whOutputData[30] 7.697Rise  SLOW 3.213Rise  FAST 0.213
3 whOutputData[31] 7.720Rise  SLOW 3.236Rise  FAST 0.190
Worst Case Summary ~ 7.942Rise  SLOW 3.191Rise  FAST 0.233
Bus Skew: 0.233ns
|2 Datasheet - timing_1 x| 5 Datasheet - timing_2 X 4 b+ &=
Figure 55: Report Datasheet — Improved Skew
Implementation www.xilinx.com

UG986 (v2016.4) November 30, 2016

| Send Feedback I

52


http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG986&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Implementation&releaseVersion=2016.4&docPage=52

& XILINX

ALL PROGRAMMABLE.

Lab 3: Manual and Directed Routing

Step 5: Using Manual Routing to Reduce Clock Skew

To adjust the skew, begin by examining the current routing of the nets,
wbOutputData_ OBUF[14:31], to see where changes might be made to consistently add delay. You
can use a Tcl FOR loop to report the existing routing on those nets, to let you examine them more

closely.

1. Inthe Tcl Console, type the following command:
for {set i 14} {$i<32} {incr i} {

}

This For loop initializes the index to 14 (set 1 14), and gets the ROUTE property to return the

puts "$i1 [get_property ROUTE [get_nets -of [get pins -of \

[get_cells wbOutputData_reg[$i]] -Ffilter DIRECTION==0UT]]]"

details of the route on each selected net.

The Tcl console returns the net index followed by relative route information for each net:

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4
{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4
{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

{ CLBLL_LL_AQ CLBLL_LOGIC_OUTS4

WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO
WW2BEGO

IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34
IMUX_L34

101_OLOGICO_D1
101_0LOGIC1_D1
101_0LOGICO_D1
101_0LOGIC1_D1
101_0LOGICO_D1
101_0LOGIC1_D1
101_0LOGICO_D1
101_0LOGIC1_D1
101_0LOGICO_D1
101_0LOGIC1_D1
101_0LOGICO_D1
101_0LOGIC1_D1
101_0LOGICO_D1
101_0LOGIC1_D1
101_0LOGICO_D1
101_0LOGIC1_D1

101_0LOGICO_D1

101_0LOGIC1_D1

L101_OLOGICO_0Q
L101_OLOGIC1_0Q
L101_OLOGICO_0Q
L101_OLOGIC1_0Q
L101_OLOGICO_0Q
LI01_OLOGIC1_0Q
L101_OLOGICO_0Q
L101_OLOGIC1_0Q
L101_0LOGICO_0Q
LI01_OLOGIC1_0Q
L101_OLOGICO_0Q
L101_OLOGIC1_0Q
L101_0LOGICO_0Q
L101_OLOGIC1_0Q
L101_OLOGICO_0Q
L101_OLOGIC1_0Q
L101_0LOGICO_0Q
L101_OLOGIC1_0Q

L101_00 }
LI01_ 01 }
LI01_00 }
LI01_01 }
LI101_00 }
LI01_ 01 }
LI101_00 }
L101_ 01 }
LI01_00 }
LI01_01 }
L101_00 }
LI101_ 01 }
LI01_00 }
LI01_01 }
LI101_00 }
L101_01 }
LI101_00 }
LI01_ 01 }

From the returned ROUTE properties, note that the nets are routed from the output registers using
identical resources, up to node IMUX_L34. Beyond that, the Vivado router uses different nodes for
odd and even index nets to complete the connection to the die pad.

By reusing routing paths, you can manually route one net with an even index, like
wbOutputData_ OBUF[14], and one net with an odd index, such as wbOutputData_ OBUF[15],
and copy the routing to all other even and odd index nets in the group.

2. Inthe Tcl Console, select the first net with the following command:

select objects [get nets -of [get_pins -of \
[get_cells wbOutputData reg[14]] -filter DIRECTION==0UT]]

3. In the Device window, right-click to open the popup menu and select Unroute.

4. Click Yes in the Confirm Unroute dialog box.

The Device view displays the unrouted net as a fly-line between the register and the output pad.

5. Click the Maximize button ‘5 to maximize the Device window.
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6. Right-click the net and select Enter Assign Routing Mode.

The Target Load Cell Pin dialog box opens, as seen in Figure 56, to let you select a load pin to route
to or from. In this case, only one load pin populates: woOutputData_OBUF[14]_inst.

4“_ Assign Routing: Target Load Cell Pin @

,'0', Please choose a target load cell pin you want to route to/from. Select 'No Load' if
¥ unsure of target load cell pin.

Cell Fins
1
Mame Dir BEL Pin Cell MNet Delay (ps) Routed
I Input IM whOutputData_OBUF[14]_inst
F T 3 @
Load Net Delays |
| Mo Load | | Exit Mode |

Figure 56: Target Load Cell Pin Dialog Box

7. Select the load cell pin, and click OK.

The Vivado IDE enters into Assign Routing mode, displaying a new Routing Assignment window
on the right side of the Device window, as shown in the following figure.

T m e

Routing Assignment

Net: [ [ wbOutputData_OBUF[14]

4 Options
Number of hops: 1B -201
Maximum number of neighbars: 1,000 [10 - 50000]

| Allows overlap with unfixed nets
Neighbor Nodes (one hop from 'CLBLL_LL_AQ")

A Name Base Tile

Assigned Nodes

A Name Base Tile

") CLBLL_LL_AQ CLBLL_L X2Y50
%1 CLBLL_LOGIC_OUTS4 CLBLL L X2Y50

' Net Gap: 1
= IMUX_L34 INT_L_X0YS0
= IOLOLOGICO_ D1 LIOI3_SING_X0YSO
“, LIDL_OLOGIC0_0Q  LIOB3_SING_X0YS0
=, LIOL 00 LIOIB_SING_X0YS0

(@) Ready to assign routing

Assign Routing... | | Exit Mode

Figure 57: Assign Routing Mode
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The Routing Assignment window includes the following sections, as seen in Figure 57:
0 Net: Displays the current net being routed.
0 Options: Are hidden by default, and can be displayed by clicking Options.

— Number of Hops: Defines how many programmable interconnect points, or PIPs, to look
at when reporting the available neighbors. The default is 1.

— Number of Neighbors: Limits the number of neighbors displayed for selection.

— Allow Overlap with Unfixed Nets: Enables or disables a loose style of routing which can
create conflicts that must be later resolved. The default is ON.

o0 Neighbor Nodes: Lists the available neighbor PIPs/nodes to choose from when defining the
path of the route.

0 Assigned Nodes: Shows the currently assigned nodes in the route path of the selected net.

0 Assign Routing: Assigns the currently defined path in the Routing Assignment window as
the route path for the selected net.

o0 Exit Mode: Closes the Routing Assignment window.

As you can see in Figure 57, the Assigned Nodes section displays six currently assigned nodes. The
Vivado router automatically assigns a node if it is the only neighbor of a selected node and there
are no alternatives to the assigned nodes for the route. In the Device window, the assigned nodes
appear as a partial route in orange.

In the currently selected net, wbOutputData_OBUF[14], nodes CLBLL_LL_AQ and
CLBLL_LOGIC_OUTS4 are already assigned because they are the only neighbor nodes available to
the output register, wbOutputData_reg[14]. The nodes IMUX_L34, 101_OLOGICO_D1,
LIOI_OLOGICO_0Q, and LI01_0O are also already assigned because they are the only neighbor
nodes available to the destination, the output buffer (OBUF).

A gap exists between the two routed portions of the path where there are multiple neighbors to
choose from when defining a route. This gap is where you will use manual routing to complete the
path and add the needed delay to balance the clock skew.

You can route the gap by selecting a node on either side of the gap and then choosing the
neighbor node to assign the route to. Selecting the node displays possible neighbor nodes in the
Neighbor Nodes section of the Routing Assignment window and appear as dashed white lines in
the Device window.

O TIP: The number of reachable neighbor nodes displayed depends on the number of hops defined
(n the Options.
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8. Under the Assigned Nodes section, select the CLBLL_LOGIC_OUTS4 node before the gap.

The available neighbors appear as shown in the following figure.

To add delay to compensate for the clock skew, select a neighbor node that provides a slight detour

over the more direct route previously chosen by the router.

=

L | 72

el

"4

¢-}.

Routing Assignment

Net: | ./ wbOutputData_OBUF[14]

4 Options
Number of hops: 1B
Maximum number of neighbors: 1,000 [t

[¥] Allows overlap with unfixed nets

m 'CLBLL_LOGIC_DOUTS4'")

Neighbor Nodes (one

N Name Base Tile

= DELBELU  INI_L_XZY3U
™ NL1BEG_N3 INT_L_X2Y50
= BYP_ALT1 INT_L_X2¥50
™ FAN_ALT4 INT_L_X2¥Y50
= NWEBEGOD INT_L_X2¥50
™, NW2BEGD INT_L_X2¥Y50
™ NRIBEGO INT_L_X2¥50
™ NN6BEGD INT_L_X2¥Y50
T2 NM2BEGD  INT_L X2¥50
2 NEGBEGO INT_L_X2Y50
|~ NE2BEGD [INT_

=2 IMUX_LS INT_L_X2¥50
T IMUX 141  INT L X2Y50

Assigned Nodes

N Name Base Tile

%2 CLBLL_LL_AQ CLBLL_L_X2Y50
%2 CLBLL_LOGIC_OUTS4 CLBLL_L_X2Y50

i Net Gap: 1
IMUX_L34 INT_L_X0YS0
I01_OLOGICO_D1 LIOI3_SING_X0Y50
LIDI_OLOGICO_0GQ  LIOB_SING_X0YS0
LIOT_0O0 LIOI3_SING_X0Y50

Wt

(@) Ready to assign routing

I Assign Routing... || Exit Mode

1

Figure 58: Routing the Gap from CLBLL_LOGIC_OUTS4

9. Under Neighbor Nodes, select node NE2BEGO.

This node provides a routing detour to add delay, as compared to some other nodes such as

WW2BEGO, which provide a more direct route toward the output buffer. Clicking a neighbor node

once selects it so you can explore routing alternatives. Double-clicking the node temporarily assigns
it to the net, so that you can then select the next neighbor from that node.

10. In Neighbor Nodes, assign node NE2BEGO by double-clicking it.

This adds the node to the Assigned Nodes section of the Routing Assignment window, which

updates the Neighbor Nodes.
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11. In Neighbor Nodes, select and assign nodes WR1BEG1, and then WR1BEG2.

TIP:

O In case you assigned the wrong node, you can select the node from the Assigned Nodes
list, right click, and select Remove on the context menu.

You can turn off the Auto Fit Selection & in the Device view if you would like to stay at the
same zoom level.

The following figure_shows the partially routed path using the selected nodes shown in orange. You
can use the automatic routing feature to fill the remaining gap.

Device

Routing Assignment

Net: |_J'v.beutputDatafOEUF[M] ‘

4 QOptions
Number of hops: 1B -20]
Maximum number of neighbors: 1,000% [10 - 50000]

| Allow overlap with unfixed nets
Neighbor Nodes (one hop from "WR1BEG2

| wame Base Tile

", WRI1BEG3 INT R_X1Y51 -
%, FAN_ALT7 INT_R_X1Y51
=, FAN_ALTS INT_R_X1Y51
= BYP_ALT2 INT_R_X1Y51
", BYP_ALTS INT_R_X1Y51
", NW2BEGZ INT R_X1Y51
%, NN2BEG2 INT_R_X1Y51
= IMUX5  INT_R_X1Y51
= IMUX44  INT_R_X1Y51
%, IMUX36 INT R_X1Y51
T, IMUX35 INT R_X1Y51
=, IMUX28  INT_R_X1Y51
= IMUX21  INT_R_X1Y51 -

]

Assigned Nodes

% Name Base Tile
2 CLBLL_LL_AQ CLBLL_L_X2Y50
. CLBLL LOGIC_QUTS4 CLBLL L X2Y50
= NEZBEGD INT_L_X2¥50
= WR1BEG1 INT_R_X3Y51
*2 WR1BEGZ INT_L_X2Y51
' Net Gap: 1
T IMUX_L34 INT_L_X0YS0

2 101_OLOGICO_D1 LIOI3_SING_X0Y50
% LIOLOLOGICO_0Q  LIOI3_SING_X0Y50
2 LI01_00 LIOI3_SING_X0Y50

(i) Ready to assign routing

Assign Routing... | | Exit Mode

Figure 59: Closing the Gap
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12. Under the Assigned Nodes section of the Routing Assignment window, right-click the Net Gap,
and select Auto-Route, as shown in the following figure.

Assigned Nodes

A | Name Base Tile
=, CLBLL_LL_AQ CLBLL_L_X2Y50

= CLBLL_LOGIC_OUTS4 CLBLL_L_X2Y50

| »

= NE2BEGO INT_L_X2Y50
= WR1BEG1 INT_R_X3Y51 3
= WR1BEG2 INT_L_X2¥51

MUX_L34 Auto-Route

oI
B I

OI_OLOGICO_D1

& Mode Properties... Ctrl+E

@ Ready to assign routing Export to Spreadsheet. ..

[ Assign Routing... H Exit Mode l

Figure 60: Auto-Route the Gap

The Vivado router fills in the last small bit of the gap. With the route path fully defined, you can
assign the routing to commit the changes to the design.

13. Click Assign Routing at the bottom of the Routing Assignment window.

The Assign Routing dialog box opens, as seen in the following figure. This displays the list of
currently assigned nodes that define the route path. You can select any of the listed nodes,
highlighting it in the Device window. This lets you quickly review the route path prior to committing
it to the design.

al‘:t. Assign Routing

X5

':| Routing for net 'wbOutputData_OBUF[14]" will be assigned

Mame
T, CLBLL_LL_AQ

NEZBEGD
WR1BEG1
WR1BEG2
SWIBEG1
MUX_L34
OI_OLOGICO_D1
LIOI_OLOGICO_0Q
LIOI_D0

I
I

CLBLL_LOGIC_OUTS4 CLBLL_L_X2Y50

Base Tile
CLELL_L_X2Y50

INT_L_X2YSO
INT_R_%3¥51
INT_L_X2¥51
INT_R_X1Y51
INT_L_X0YS0
LIOI3_SING_X0Y50
LIOI3_SING_X0YS50
LIOI3_SING_X0YS0

! .J'l.II.JI.JI.JI.IH.IH.II.JI

ix Routing

[ oK ” Cancel ]

Figure 61: Assign Routing — Even Nets
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Make sure Fix Routing is checked, and click OK.

The Fix Routing checkbox marks the defined route as fixed to prevent the Vivado router from
ripping it up or modifying it during subsequent routing steps. This is important in this case, because
you are routing the net manually to add delay to match clock skew.

Examine the Tcl commands in the Tcl Console.

The Tcl console reports any Tcl commands that assigned the routing for the current net. Those
commands are:

set_property is_bel fixed 1 [get_cells {wbOutputData_reg[14]

wbOutputData OBUF[14]_inst }]

set_property is_loc fixed 1 [get cells {wbOutputData reg[14]

wbOutputData OBUF[14] inst }]

set_property fixed_route { { CLBLL_LL_AQ CLBLL_LOGIC_OUTS4 NE2BEGO WR1BEG1
WR1BEG2 SW2BEG1 IMUX_L34 101_OLOGICO_D1 LIOI_OLOGICO_OQ LIOI_O0 } 3} [get_nets
{wbOutputData_OBUF[14]1}]

IMPORTANT: The FIXED_ROUTE property assigned to the net, wbOutputData_OBUF[14], uses a
directed routing string with a relative format, based on the placement of the net driver. This lets
you reuse defined routing by copying the FIXED_ROUTE property onto other nets that use the
same relative route.

After defining the manual route for the even index nets, the next step is to define the route path for
the odd index net, wbOutputData_OBUF[15], applying the same steps you just completed.

In the Tcl Console type the following to select the net:
select_objects [get_nets wbOutputData OBUF[15]]

With the net selected:

a. Unroute the net.

b. Enter Routing Assignment mode.

c. Select the Load Cell Pin.

d. Route the net using the specified neighbor nodes (NE2BEGO, WR1BEG1, and WR1BEG?2).
e. Auto-Route the gap.

f.  Assign the routing.
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The Assign Routing dialog box, shown in the following figure, shows the nodes selected to
complete the route path for the odd index nets.

al‘;f_=. Assign Routing @

,0| Routing for net 'wbOutputData_OBUF[15]' will be assigned

Mame Base Tile

T, CLBLL LL_AQ CLBLL_L X2Y51
%, CLBLL_LOGIC_DUTS4 CLBLL_L_X2Y¥51
=, NEZBEGO INT_L_X2Y51
T, WRI1BEG1 INT_R_X3¥52
T, WRIBEG2 INT_L_X2Y52

% SW2BEG1L INT_R_X1Y52
T IMUX_L34 INT_L_X0YS51
%, IOl OLOGIC1 D1  LIOI3 XOYS51
% LIOI_OLOGIC1 00 LIOI3 XO0YS51
% LI0I_O1 LIOI3 X0YS51

| Fix Routing

[ oK l | Cancel

Figure 62: Assign Routing — Odd Nets

You routed the wbOutputData OBUF[14] and wbOutputData OBUF[15] nets with the detour
to add the needed delay. You can now run the Report Datasheet command again to examine the
timing for these nets with respect to the lower order bits of the bus.

18. Switch to the Timing Datasheet report window. Notice the information message in the banner of the
window indicating that the report is out of date because the design was modified.

19. In the Timing Datasheet report, click Rerun to update the report with the latest timing information.

20. Select Max/Min Delays for Groups > Clocked by wbClk > wbOutputData[0] to display the
timing info for the wbOutputData bus, as seen in Figure 63.
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Timing - Datasheet - timing_1 — 0O a %

4 MaxMin Delays for Groups - Clocked by wbClk - wbOutputData[0]

’ O\ Setup Setup Process d Hold Hold Process Source Offset
SRECS Setup Edge Corner bz Edge Carner to Center
<@ whOutputData[d] 7.911Riss  SLOW 3.303Rise  FAST 0,000 .
3 Setup between Clocks <@ whOutputData[0] 7.911 Rise sLOW 3.303Rise  FAST 0,000 [
B Setup/Hold for Input Buses <@ whOutputData[1] 7.878 Rise sLOW 3.271Rise  FAST 0.033
BB Clocked by whek <@ whOutputData[7] 7.875 Rise sLOW 3.269 Rise  FAST 0.035
-1 whInputData <@ whOutputData[3] 7.874 Rise sLOW 3.267Rise  FAST 0.037
= Max/Min Delays for Output Buses < whOutputData[4] 7.868 Rise  SLOW 3.261Rise  FAST 0.043
&6 Clocked by whClk < whOutputData[s] 7.919Rise  SLOW 3.311Rse  FAST 0.008
s |5 whOutputData < whOutputDataf6] 7.915Rise  SLOW 3.306 Rise  FAST 0.004
B Max/Min Delays for Groups <@ whOUtpUIData[7] 7.881Rse  SLOW 3.274Rise  FAST 0.030
B+ Clacked by whClk <@ whOUtpUIData[s] 7.886Rise  SLOW 3.278Rise  FAST 0.025
~@ < whOutputData[d] 7.914 Rise sLow 3.306 Rise  FAST 0.004
<@ whOutputData[10] 7.905Rise  SLOW 3.297Rise  FAST 0.006
<@ whOutputData[11] 7.897Rise  SLOW 3.290Rise  FAST 0.014
<@ whOutputData[137] 7.891Rise  SLOW 0.019
< whOutputData[13] 7.942Rise  SLOW 0.032
2 o I
] T I TS STV _
< wbOutputData[16] 7.718 Rise SLOW 3.231 Rise FAST 0.193 |
<@ whOutputData[17] 7.681Rise  SLOW 3.193Rise  FAST 0.230
<@ whOutputData[18] 7.678Rise  SLOW 3.191Rise  FAST 0.233
<@ whOUutputData[19] 7.730Rise  SLOW 3.242Rise  FAST 0.181
<@ whOutputData[20] 7.723Rise  SLOW 3236 Rise  FAST 0.188
<@ whOutputData[21] 7.691Riss  SLOW 3.203Rise  FAST 0.220
<7 whOutputData[22] 7.687Riss  SLOW 3.200Rise  FAST 0.224
<@ whoutputData[23] 7.701Rise  SLOW 3.214Rise  FAST 0.210
<@ whOutputData[24] 7.695Rise  SLOW 3.208Rise  FAST 0.215
<7 whOutputData[25] 7.694Rise  SLOW 3.208Rise  FAST 0.217
<7 whOutputData[26] 7.688Rise  SLOW 3.201Rise  FAST 0.223
<@ whOutputData[27] 7.715Rise  SLOW 3.228Rise  FAST 0.196
<7 whOutputData[2a] 7.707Rise  SLOW 3.222Rise  FAST 0.204
< whOutputData[29] 7.705Rise  SLOW 3.221Rise  FAST 0.205
<7 whOutputData[3q] 7.697Rise  SLOW 3.213Rise  FAST 0.213
<@ whOutputData[31] 7.720Rise  SLOW 3236 Rise  FAST 0.190 |
Worst Case Summary ~ 7.987Rise  SLOW 3.191Rise  FAST 05Es -

Bus Skew: 0.233ns

% Datasheet - timing_1 X I NE]

Figure 63: Report Datasheet — Improved Routing

You can see from the report that the skew within the rerouted nets, wbOutputData[14] and
wbOutputData[15], more closely matches the timing of the lower bits of the output bus,
wbOutputData[13:0]. The skew is within the target of 100 ps of the reference pin
wbOutputData[O].

In Step 6, you copy the same route path to the remaining nets, woOutputData_OBUF[31:16], to
tighten the timing of the whole wbOutputData bus.
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Step 6: Copying Routing to Other Nets

To apply the same fixed route used for net wbOutputData_OBUF[14] to the even index nets, and the
fixed route for wbOutputData_ OBUF[15] to the odd index nets, you can use Tcl For loops as
described in the following steps.

1
2.

Select the Tcl Console tab.

Set a Tcl variable to store the route path for the even nets and the odd nets:

set even [get property FIXED ROUTE [get nets wbOutputData OBUF[14]1]
set odd [get _property FIXED _ROUTE [get nets wbOutputData OBUF[15]]1]

Set a Tcl variable to store the list of nets to be routed, containing all high bit nets of the output data
bus, wbOutputData OBUF[16:31]:

for {set 1 16} {$i<32} {incr i} {
lappend routeNets [get nets wbOutputData OBUF[$i]]
}

Unroute the specified nets:

route_design -unroute -nets $routeNets

Apply the FIXED_ROUTE property of net wbOutputData_OBUF[14] to the even nets:

for {set i 16} {$i<32} {incr i 2} {
set_property FIXED_ROUTE $even [get_nets wbOutputData_ OBUF[$i]]
}

Apply the FIXED_ROUTE property of net wbOutputData_OBUF[15] to the odd nets:

for {set i 17} {$i<32} {incr i 2} {
set_property FIXED_ROUTE $odd [get_nets wbOutputData_ OBUF[$i]]
}

The even and odd nets of the output data bus, as needed, now have the same routing paths, adding
delay to the high order bits. Run the route status report and the datasheet report to validate that
the design is as expected.

In the Tcl Console, type the following command:

report_route_status

TIP: Some routing errors might be reported if the routed design included nets that use some of
the nodes you have assigned to the FIXED_ROUTE properties of the manually routed nets.
Remember you enabled Allow Overlap with Unfixed Nets in the Routing Assignment window.

If any routing errors are reported, type the route_design command from the Tcl console.

The nets with the FIXED_ROUTE property takes precedence over the auto-routed nets.
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9. After route_design, repeat the report_route_status command to see the clean report.
10. Examine the output data bus in the Device view, as seen in the following figure:

e All nets from the output registers to the output pins for the upper bits 14-31 of the output bus
wbOutputData have identical fixed routing sections (shown as dashed lines).

e You do not need to fix the LOC and the BEL for the output registers. It was done by the
place_cell command in an earlier step.

Implemented Design * - constrs_2 | xc7k70tfbg484 2 (active) X

% Project Summary X | Device X

3 Properties

3] Metlist

Figure 64: Final Routed Design

Having routed all the upper bit nets, wbOutputData_OBUF[31:14], with the detour needed for
added delay, you can now re-examine the timing of output bus.

11. Select the Timing tab in the Results window area.

Notice the information message in the banner of the window indicating that the report is out of
date because timing data has been modified.

12. Click rerun to update the report with the latest timing information.

13. Select the Max/Min Delays for Groups > Clocked by wbClk > wbOutputData[0] section to
display the timing info for the wbOutputData bus.

As shown in Figure 65, the clock-to-out timing within all bits of output bus wbOutputData is now
closely matched to within 83 ps.

14. Save the constraints to write them to the target XDC, so that they apply every time you compile the
design.
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15. Select File > Save Constraints to save the placement constraints to the target constraint file,
bft_full _xdc, in the active constraint set, constrs_2.

Timing - Datasheet - timing_1

ATZ€ 42

4 Max/Min Delays for Groups - Clocked by wbClk - wbOutputData[0]

General Information
Setup/Hold for Input Ports
MaxMin Delays for Qutput Ports
Setup between Clocks
Setup/Hold for Input Buses
=5 Clocked by whClk

3 whInputData
7 MaxMin Delays for Qutput Buses
- Clocked by whClk
5 wbOutputData
7 Max/Min Delays for Groups
2+ Clocked by whClk

£ Datasheet - timing_1 X

b o
@

Source

<4 wbOutputData[0]
< whbOutputData[0]
=3 whOutputData[1]
<4 whOutputData[2]
<4 whOutputData[3]
<3 whOutputData[4]
<3 wbOutputData[5]
<4 wbOutputData[6]
-3 wbOutputData[7]
= whOutputData[§]
<3 whOutputData[9]
< whOutputData[10]
-3 whOutputData[11]
<4 whOutputData[12]
<4 wbOutputData[13]
< whOutputData[14]
=3 whOutputData[15]
<3 wbOutputData[16]
<4 whOutputData[17]
¥ whOutputData[18]
<3 wbOutputData[19]
< wbOutputData[20]
- whbOutputData[21]
=3 whOutputData[22]
<3 wbOutputData[23]
< whOutputData[24]
-3 whOutputData[25]
<3 wbOutputData[26]
<4 wbOutputData[27]
< whbOutputData[28]
=3 whOutputData[23]
<3 wbOutputData[30]
<4 whOutputData[31]
Waorst Case Summary

Setup
Edge
7.911 Rise
7.911 Rise
7.878 Rise
7.875 Rise
7.874 Rise
7.868 Rise
7.919 Rise
7.915 Rise
7.881 Rise
7.886 Rise
7.914 Rise
7.905 Rise
7.897 Rise
7.891 Rise
7.942 Rise
7.949 Rise
7.987 Rise
7.981 Rise
7.945 Rise
7.942 Rise
7.994 Rise
7.986 Rise
7.955 Rise
7.951 Rise
7.965 Rise
7.959 Rise
7.953 Rise
7.951 Rise
7.978 Rise
7.970 Rise
7.969 Rise
7.961 Rise
7.984 Rise
7.994 Rise

Setup

Setup Process
Corner
SLOW
SLOW
SLOW
SLOwW
SLOW
SLOW
SLOW
SLOW
SLOW
SLOW
SLOwW
SLOW
SLOW
SLOW
SLOW
SLOW
SLOW
SLOwW
SLOW
SLOW
SLOW
SLOW
SLOW
SLOW
SLOwW
SLOW
SLOW
SLOW
SLOW
SLOW
SLOW
SLOwW
SLOW
SLOW

Hold
Edge
3.303 Rise
3.303 Rise
3.271 Rise
3.269 Rise
3.267 Rise
3.261 Rise
3.311 Rise
3.306 Rise
3.274 Rise
3.278 Rise
3.306 Rise
3.297 Rise
3.290 Rise
3.284 Rise
3.335 Rise
3.328 Rise
3.366 Rise
3.360 Rise
3.323 Rise
3.320 Rise
3.371 Rise
3.365 Rise
3.333 Rise
3.330 Rise
3.344 Rise
3.338 Rise
3,338 Rise
3.331 Rise
3.357 Rise
3.351 Rise
3.351 Rise
3.343 Rise
3.366 Rise
3.261 Rise

Hold

Hold Process

Corner

FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST
FAST

Source Offset
to Center
0.000
0.000
0.033
0.035
0.037
0.043
0.008
0.004
0.030
0.025
0.004
0.008
0.014
0.019
0.032
0.038
0.076
0.070
0.034
0.031
0.083
0.075
0.044
0.040
0.054
0.048
0.047
0.041
0.067
0.059
0.053
0.050
0.073
0.083

m

Bus Skew: 0.083ns

B

Figure 65: Report Datasheet — Final

Conclusion

In this lab, you did the following:

e Used manual placement techniques to improve the timing of selected nets.

Analyzed the clock skew on the output data bus using the Report Datasheet command.

e Used the Assign Manual Routing Mode in the Vivado IDE to precisely control the routing of a

net.

e Used the FIXED_ROUTE property to copy the relative fixed routing among similar nets to
control the routing of the critical portion of the nets.
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Lab 4: Vivado ECO Flow

Introduction

In this lab, you will learn how to use the Vivado® Engineering Change Order (ECO) flow to modify your
design post implementation, implement the changes, run reports on the changed netlist, and generate
programming files.

For this lab, you will use the design file that is included with this guide and is targeted at the Kintex®
UltraScale® KCU105 Evaluation Platform. For instructions on locating the design files, see Locating
Design Files for Lab 4.

A block diagram of the design is shown in the following figure.

MMCM__Jclock (100MHz2) <28:.0>

VIO
- <28:25>
Reset
I i 3 : count=3:0>
Pause State Machine = zs?ak:gm 4b0_count<3:0> LEDs<7:0>
Toggle — | —)

mult<7:0>

Figure 66: Block Diagram of the Design

In this design, a mixed-mode clock manager (MMCM) is used to synthesize a 100 MHz clock from the
300 MHz clock provided by the board.

A 29-bit counter is used to divide the clock down further. The 4 most significant bits of the counter
form the count<3:0> signal that is 0-extended to 8 bits and drives the 8 on-board LEDs through an
8-bit 2-1 mux.

The count<3:0> signal is also squared using a multiplier, and the product drives the other 8 inputs of
the mux. A Toggle signal controls the mux select and either drives the LEDs (shown in the following
figure) with the counter value or the multiplier output.

A Pause signal allows you to stop the counter, and a Reset signal allows you to reset the design. The
Toggle, Pause, and Reset signals can either be controlled from on-board buttons shown in Figure 67
or a VIO in the Hardware Manager as shown in Figure 68. The VIO also allows you to observe the status
of the LEDs. The following figures show the location of the push-buttons and the LEDs on the KCU105
board and a Hardware Manager dashboard. These allow you to control the push button and observe
the LEDs through the VIO.
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Figure 67: KCU105 On-Board Push Buttons and LEDs

4: Vivado ECO Flow
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Figure 68: VIO Dashboard
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Step 1: Creating a Project Using the Vivado New Project
Wizard

To create a project, use the New Project wizard to name the project, to add RTL source files and
constraints, and to specify the target device.

1.

2
3.
4

Open the Vivado Design Suite integrated development environment (IDE).
In the Getting Started page, click Create New Project to open the New Project wizard.
Click Next.

In the Project Name page, do the following:

a. Name the new project project_ECO_lab.

b. Provide the project location C:/Vivado_Tutorial.

c. Ensure that Create project subdirectory is selected.

d. Click Next.

In the Project Type page, do the following:

a. Specify the Type of Project to create as RTL Project.

b. Leave the Do not specify sources at this time check box unchecked.
c. Click Next.

In the Add Sources page, do the following:

a. Set the Target Language to Verilog.
b. Click Add Files.
¢. Inthe Add Source Files dialog box, navigate to the /src/lab4 directory.

o

Select all Verilog source files.

Click OK.

f.  Verify that the files are added, and that Copy Sources into Project is selected.
g. Click Next.

In the Add Existing IP page, do the following:

a. Click the Add button .h and then select Add Files.

b. Inthe Add Configurable IP dialog box, navigate to the /src/l1ab4/ 1P directory.
c. Select all of the XCI source files and click OK.

d. Verify that the files are added and Copy sources into project is selected.

e. Click Next.
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8. In the Add Constraints dialog box, do the following:

a. Click the Add button 'h and then select Add Files.
b. Navigate to the /src/lab4 directory and select ECO_kcul05.xdc.
c. Click Next.
9. In the Default Part page, do the following:
a. Specify the xcku040-ffvall56-2-e part for the KC705 platform.
Note: You can also select Boards and then select Kintex-UltraScale KCU105 Evaluation Platform.
b. Click Next.

10. Review the New Project Summary page. Verify that the data appears as expected, per the steps
above.

11. Click Finish.
Note: It might take a moment for the project to initialize.

12. In the Sources window in the Vivado IDE, expand top to see the source files for this lab.

Sources PO e

M A opag '
N = OLJ‘}-I‘ s E]

—+{= Design Sources (1)
=@ top (top.v) (3)
{—--i}ﬁ lelk_0 - clk_wiz_0 (clk_wiz_0.xci)
H-LF vio_inst_0 - vio_0 (vio_0.xci)
@ my_mult_0 - multiplier (mult.y)
=t~ Constraints (1)
=)= constrs_1 (1)
- ECO_keu105.xde
+H= Simulation Sources (1)

Hierarchy | IP Sources | Libraries | Compile Order

Figure 69: Sources Window
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Step 2: Synthesizing, Implementing, and Generating the
Bitstream

1. In the Flow Navigator, under Program and Debug, click Generate Bitstream.
This synthesizes, implements, and generates a bitstream for the design.
The No Implementation Results Available dialog box appears.

2. Click Yes.

After bitstream generation completes, the Bitstream Generation Completed dialog box appears.
Open Implemented Design is selected by default.

3. Click OK.

4. Inspect the Timing Summary report and make sure that all timing constraints have been met.

Timing - Timing Summary - impl_1 0O a =®
QA T e
QA TEE ? 4 Design Timing Summary
() Thisisa saved report *|' | setup Hold Pulse Width
G | Inf i =
e catinan Worst Negative Slack (WNS): 6.412 ns Worst Hold Slack (WHS):  0.013ns Worst Pulse Width Slack (WPWS): 0.666 ns
Desig q i Total Negative Slack (TNS):  0.000 ns Total Hold Slack (THS): 0.000 ns Total Pulse Width Negative Slack (TPWS): 0.000 ns
'C‘_DE:E;“{”TWEW 2 Humber of Failing Endpoints: 0 Number of Failing Endpoints: 0 Number of Failing Endpoints: 0
eck Timin
no_clock .-,TQ Total Number of Endpoints: 4454 Total Number of Endpoints: 4454 Total Number of Endpoints: 2462
cunstant;cluck'\'.:: - . .
[ . th clack (1) ~ | All user specified timing constraints are met.
4 »
Timing Summary - impl_1 4B

Figure 70: Timing Summary Report

You can use the generated bitstream programming file to download your design into the target FPGA
device using the Hardware Manager. For more information, see the Vivado Design Suite User Guide:
Programming and Debugging (UG908).
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Step 3: Validating the Design on the Board

This step is optional, but will help you understand the ECO modifications that you will make in
Step 4: Making the ECO Modifications.

1. From the main menu, select Flow > Open Hardware Manager.

The Hardware Manager window opens.

¢+ project_ECO_tab - [C/Data/Mivado_Tularsl/project_ECO_labfproject_ECO_labixpr] - Vivado 2016.1 EI&Ers]
Fde Gt Flow Tools Window Loyout View Help G- Sasech command
2Rl X PO K E G |Eveful Layout - I % % | ®posboard | write_bitstream Complete
[repr— s Mandware Manager - unconnected ' X
QAT W @ o hardware target s open. Open targat
Hesdware -

'mgﬂh:mw sz=l®rnE

¥ Add Sources

 Language Tempiates

IF 1P catalog
* P tagrator

7, Creste Block Design

B Open Rlock Design
Wy Generate Block Dessgn

& Samuation
& Simulation Settings - i T
&) run Simulation PRINTSIS
4 RTL Analysis =
i Elaboration Settings
&® Open Elsborated Desgn
« Syrihesis
@) Synthiss Settings. Selact an ohjact 10 sie proparties
B Run Synthests
+ &* Open Syntheszed Design
4 Implementation
@ Implementation Settings o
[ Run Implemntation Fel Corrcte e W
o M risiabed scamaing scurce i
— —— i@ INPO: (12 Flow 19-234] Gefreshing If Tepositories
Prog Debug INFD: [IF_Flew 13-1704] o user IF sepsattosies spe
= 21 by M| gnro: (12 riew 19-2313) Losced Vivade 1P reposttary Lank/Vivade/ 2046, 1/daTa/ip" .
@ Bistroam Sattings el open_projese: Time {2): opu = 00:00:05 ; elapaed = 5 . Memory (ME}: peak = 4422441 7 gain = 0,000
2 Generote Bitstream 3 | update_compile orde: -fileset soutces 1 E
# [l Hardware Mannger ] open v =
B Open Target i .-
@ Frogram Device B -

% 2dd Configuration Memory Device

ﬁ."'. e : .. q,s,mu yolmnvnu ‘..I.D.;n“‘

Figure 71: Hardware Manager Window

2. Connect to a hardware target Using hw_server.

O TIP: For more information about different ways to connect to a hardware target, refer to
the Vivado Design Suite User Guide: Programming and Debugging (UG908).
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Hardware Manager - xcodmm<40/xilinx_tcf/Digilent/210308957267

Lab 4: Vivado ECO Flow
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device index = 0) is programmed with a design that has 1 ILA core(s).
device index = 0) is programmed with a design that has 1 VIO core(s).

Tcl Console

5o set_property

iy i current_hw_device [lindex [get_hw dewvices] 0]

= eah_hw_device [lindex [get_hw devices] 0]

Dl] NF0: [Labtools 27-2302] Device xclkuf40 (JTAG

,_6§J i INFO: [Labtools 27-2302] Device xcku040 (JTAG

Ej INFQ: [Labtools 27-1883] Uploading ocutput probe values for VIO core [hw_wio_l1]
@ i display_hw ila data [

L

PROBES.FILE {C:/Data/Vivade_Tutorial/project ECO_lab/project_ECO_lab.runs/impl_1/debug_nets.ltx} [lindex [get_hw_devices] 0]

get_hw_ila data hw_ila data_l -of_cbjecta [get_hw _ilaa -of_cbjecta [get_hw devices xckul40_ 0] -filter {CELL_NAME=~"u_|

/5 Tcl Console | & Messages | “ Serial /O Links

[E Serial /O Scans

Figure 72: Use hw_server to Connect to a Hardware Target

3. In the Vivado Flow Navigator, under Program and Debug, click Program Device.

The Program Device dialog box opens.

¢ Program Device

Bitstream file:

[] Enable end of startup check

C:/Data/Vivado_Tutorial/project_ECO_lab/project_ECO_lab.runs/impl_1/top.bit

Debug probes file: Jata/Vivado_Tutorial/project_ECO_lab/project_ECO_lab.runs/impl_1/debug_nets.ltx

Select a bitstream programming file and download it to your hardware device. You can optionally select a
debug probes file that corresponds to the debug cores contained in the bitstream programming file.

Erogram l |

Cancel

Figure 73: Program Device Dialog Box
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4. Navigate to the Bitstream file and Debug Probes file.
5. Click Program.

Now that the FPGA is configured, you can use the on-board buttons and the on-board LEDs to
control and observe the hardware. Press the Pause button to pause the counter. Press the Toggle
button to select between the count and the multiplier result. Press the Reset button to reset the
counter.

T R a
- ,;._,;___:_:;;J}II -

s - o e

Figure 74: On-Board Push Buttons and LEDs

Alternatively, you can use the VIO to control and observe the hardware.
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If the following warning message appears, select one of the alternatives suggested in the message.

WARNING: [Labtools 27-1952] VIO hw_probe OUTPUT_VALUE properties for hw_vio(s)
[hw_vio 1] differ from output values in the VIO core(s).
Resolution:
To synchronize the hw_probes properties and the VIO core outputs choose one of
the following alternatives:

1) Execute the command “Commit Output Values to VIO Core®, to write down the
hw_probe values to the core.

2) Execute the command "Refresh Input and Output Values from VIO Core®, to
update the hw_probe properties with the core values.

3) First restore initial values in the core with the command "Reset VIO Core
Outputs®, and then execute the command "Refresh Input and Output Values from VIO
Core”.

6. Select the hw_vios tab in the dashboard and click the Add button + to add probes.
The Add Probes dialog box opens.

Add Probes b
G pig
i
Search:
Probes for hw_vio_1 (5) -
[=hEE hw_vio_1

[ OK H Cancel

Figure 75: Add Probes Dialog Box

7. Select all of the probes for hw_vio_1 and click OK.
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Unsigned Decimal.

8. In the hw_vios dashboard, select count_out_OBUF[7:0], then right-click and select Radix

& hw_ila_1 x| & hw_vies X Lapes
hw vio 1 O
% Name Value  Activity  Direction VIO
E = =
|| e X
S._ iy .--1C. pause_ym_uut [B]{ @ Debug Probe Properties... Ctrl+E
o/l 4 "-<:| reset_vp_uut [BII[ Text
i i~‘a toggle_vio_out [B]
4 == lavio_select [B] LED...
[’} =
b Radix 3 Binary
Activity Persistence 4 Octal
Rename... Hex
Hame 4 Unsignerd_Decimal
Remaove Delete Signed Decimal
Export to Spreadsheet...

Figure 76: Selecting Radix > Unsigned Decimal

9. In the hw_vios dashboard, select count_out_OBUF[7:0], then right-click and select LED.
The Select LED Colors dialog box opens.

e

¢ Select LED Colors | G |
Low Value Color: @Red -~
High Value Color: @ Green -

OK ” Cancel l

Figure 77: Select LED Colors Dialog Box

10. Select Red for the Low Value Color and Green for the High Value Color.
11. Click OK.
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12. In the hw_vios dashboard, select pause_vio_out, reset_vio_out, and toggle_vio_out, then right-click

and select Active-High Button.

® hw_ila_l % |5 hw_vies X |

b vio 1
N nName Value  Activity  Direction VIO
E [FHi5 count_out OBUF[7:0] [H] OF hwi_vio_1

pause_vio_out
reset_vio_out

hw_vio_1
hwi_vio_1

vio_select [Z Debug Probe Properties...

Ctri+E

Text

Dashboard Options
1 + 4k

| Active-High Button .

Active-Low Button

Toggle Button

Remove

Delete

Export to Spreadsheet...

Figure 78: Selecting Active-High Button

13. In the hw_vios dashboard, select vio_select and select Toggle Button.

| ® hwila_l x |5 hw_vies X |

hw vio 1
o Name Value  Activity Direction VIO
w
5 o '13 count_out_OBUF[7:0] [H] 0& Input hwi_vio_1
5-. 2 -la pause_vio_out o) Output hwi_vio_1
o la reset_vio_out o) Output hw_vio_1
g “la toggle_vio_out [T hws_vio_1
§ [Z Debug Probe Properties... Ctrl+E
Text
Active-High Button
Active-Low Button
| Togglpr Button
Rad L4
Rename.
Name 3
Remove Delete
Export to Spreadsheet...

Figure 79: Selecting Toggle Button

14. Expand count_out_OBUF[7:0] to view the VIO LEDs.
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Now that the VIO is set up, you are ready to analyze the design.

1.

2
3.
4

Toggle the vio_select button to control the hardware from the VIO.
Press the pause_vio_out button to pause the counter.
Press the toggle_vio_out button to select between the count and the multiplier result.

Press the reset_vio_out button to reset the counter.

hw_vios — 0O a x
hwi vio 1 — O =

O\ Name Value Activity Direction VIO

0l =a

_5 i El'ia count_out_OBUF[7:0] [u]121 Input hwi_vio_1
S-. =] count_out_OBUF[7] Q Input hw_v?o_l
ol 4 - I count_out_OBUF[6] Q Input hw_vio_1
§ count_out_OBUF[5] Q Input hw_vio_1
Qff - count_out_OBUF[4] Q Input hw_vio_1
i count_out_OBUF[3] Q Input hwi_vio_1
= count_out_OBUF[2] Q Input hw_vio_1
count_out_OBUF[1] Q Input hw_vio_1
count_out_OBUF[0] Q Input hw_vio_1
~a pause_vio_out o] Output hws_vio_1
~a reset_vio_out | ST Output hwe_vio_1
____toggle vio_out e [oulp
“la vio_select | Output hws_vio_1

Figure 80: hw_vios Toggle Button Window
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Step 4: Making the ECO Modifications

1. In the Flow Navigator, select the Project Manager.
2. In the Design Runs window, right-click on impl_1 and select Open Run Directory.

3. The run directory opens in a file browser, as seen in the following figure. The run directory contains
the routed checkpoint (top_routed.dcp) to be used for the ECO flow.

O TIP: In a project-based design, the Vivado Design Suite saves intermediate
implementation results as design checkpoints in the implementation runs directory.
When you re-run implementation, the previous results are deleted. Save the router
checkpoint to a new directory to preserve the modified checkpoint.

= ol
@le « Data » Vivado_Tutorial P project ECO_lab » project ECO_lab.runs b impl_1 » - ‘ 3 ‘ ‘ Search impl_1 jol |
Organize = ¢ Open -~ Burn New folder 2= « 1l Q
Favorites i Name ° Date modified Type Size .
B Desktop & top_io_placed.rpt 4/12/2016 11:39 A. e 32
§ Downloads ¢ top_optdcp 4/12/2016 11:3 vado Checkpoint... 1,429
o My Site ¢ top_placed.dcp 4/12/201611:3 vado Checkpoint... 1,802
SharePoint Sites 3 & top_power routed.rpt 4/12/201611:4 e 40
% Dropbox top_power_routed.rpx 4/12/201611:41 A. e 1,825
& OneDrive & top_power_summary_routed.pb 4/12/2016 11:41 A. e 1
' top_route_status.pb 4/12/2016 11:41 A e 1
Bl Desktop & top_route_status.rpt 4/12/2016 11:41 A. e 1
~ Libraries ¢ top_routed.dcp 4/12/2016 11:40 A. ado Checkpoint 2,082
“. Documents & top_timing_summary_routed.rpt 4/12/2016 11:40 A e 681
& Music top_timing_summary_routed.rpx 4/12/2016 11:40 564
= Pictures & top_utilization_placed.pb 4/12/2016 1 e 1|2
E, Videos & top_utilization_placed.rpt 4/12/2016 11:3¢ RPT File 11
R Frank Mueller & vivado.jou 4/12/2016 3 JOU File 1
& Computer & vivado.log 4/12/2016 3 OG File 3|s
& Network a2l < i} 3
top_routed.dcp Date modified: 4/12/2016 11:40 AM Date created: 4/12/2016 11:40 AM
‘ Vivado Checkpoint File Size: 203 MB

Figure 81: Implementation Run Directory

4. Create a new directory named ECO in the original C:/Vivado_Tutorial/project_ECO_lab
project directory, and copy the top_routed.dcp file from the implementation runs directory to
that newly created directory.

5. From the main menu, select File > Open Checkpoint.
The Open Checkpoint dialog box opens.

6. Navigate to C:/Vivado_Tutorial/project _ECO_lab/ECO and select the top_routed.dcp
checkpoint.

A dialog box opens, asking whether to close the current project.
7. Click Yes.
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8. From the main menu, select Layout > ECO.

The ECO Layout is selected. The ECO Navigator is displayed on the left of the layout (highlighted in
red in the following figure). It provides access to netlist commands, run steps, report and analysis
tools, and commands to save changes and generate programming files.

The Scratch Pad in the center of the layout (highlighted in red in the following figure) tracks netlist
changes, as well as place and route status for cells, pins, ports, and nets.

Note: ECOs only work on design checkpoints. The ECO layout is only available after you have opened
a design checkpoint in the Vivado IDE.

¢ top_routed.dcp - [C/Data/Vivado_Tutorial/project_ECO_lab/ECO/top_routed.dcp] - Vivado 2016.1 =0 WOR
File Edit Flow Tools Window Layout View Help
T H R XHNNG DO K G (S - Tex 5
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Figure 82: ECO Layout

To illustrate the capabilities of the ECO flow, you next change the functionality of the multiplier from
a square of count[3:0] to a multiply by two.
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9. From the Tcl Console, type the following command:

mark_objects -color blue [get _cells my _mult O]

O TIP: To make it easier to locate objects that are included in the ECO modifications, it helps to
mark or highlight the objects with different colors.

Schematic 7 — O o
-}|:| 96 Cells 13 I/O Ports 248 Nets

EIERR YL

-
=

|1 +&9 HHE &

Figure 83: Schematic with Multiplier Marked

10. Zoom into the multiplier in the schematic window and select the in2[3:0] pins.

Alternatively, you can type the following command in the TCL console:

select _objects [get pins my mult 0/in2[*]]
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11. Click the Disconnect Net button in the Edit section of the Vivado ECO Navigator. The net is
disconnected from the pins in the schematic.

Schematic D
3] 96Cells 131/0 Ports 248 Meis
« -~
=p
o%
SN -
= 6
b b
= mul_out_pre[7]_i_1
i FO=4/10 o|Fo=41
F LUT1
=
" my_mult_0
_
B — i
+ in1[3:0] @ out[7:0] S=default ¥¥ '_H
- nfc in2[3:0 I 7 _—
@ f m

multiplier
‘ [allla] P

Figure 84: Schematic with Net Disconnected from Pins in2[3:0]

The Tcl Console reproduces the disconnect_net command that you just executed in the ECO
Navigator. This is useful if you want to replay your ECO changes later by opening the original
checkpoint and sourcing a TCL script with the ECO commands.

Tcl Console 7 — 0O a x

E select objecta [get_pina my mult 0/in2[*]] &

g Y INFO: [Coretcl 2-6] '4' obijects selected.

=]
startgroup

|]|] disconnect_net -net {divClk_reg[28]} -objects [liat {my mult 0/in2[3]1]

.5§'J disconnect net -net {divClk reg[27]} -cbkjects [list {my mult 0/in2[2]}]

Iy disconnect_net -net [divClk_reg[26]} -objects [liat {my mult 0/in2[1]1]

h disconnect net -net {divClk reg[25]} -cbkjects [list {my mult 0/in2[0]}]

@ endgroup |_:|

E
4 I | 3
I Type a Tel command here

Figure 85: TCL Console Showing Executed ECO Commands
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The Scratch Pad is populated with the 4 nets divClk_reg[28:25] that you disconnected and the
multiplier input pins my_mult_0/in2[3:0]. Note the following in the Scratch Pad:

e The Scratch Pad connectivity column (Con) shows a check mark next to the
divClk_reg[28:25] nets, indicating that they are still connected to the other multiplier
inputs.

e Themy_mult_0/in2[3:0] pins do not show a check mark next to them because they no
longer have nets connected.

e The Place and Route (PnR) column is unchecked for everything, indicating that the
changes have not yet been implemented on the device.

Scratch Pad - O
Q2%+ —[F
Con PnR  Object Name

= B my_mult_0/in2
= I divClk_reg
I divClk_reg[25]
I divClk_reg[26]
1
1

E |
S

I divClk_reg[27
I divClk_reg[28

L4444

Figure 86: Scratch Pad Showing Status of ECO

12. In the Scratch Pad, select the {my_mult_0/in2[3], my_mult_0/in2[2], and my_mult_0/in2[0]} pins.
13. In the Edit section of the Vivado ECO Navigator, click Connect Net.

The Connect Net dialog box opens.
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<« | Scratch Pad

AzTE %+ —[E

Con PnR  Object Name

=l I divClk_reqg
I divClk_reg[25]
I divClk_reg[26]
I divClk_reg[27]
I divClk_reg[28]

= & my_mult_0o/in2
® my_mult_0/in2[3]
® my_mult_0/in2[2]
> -

L444s

It_0/in2[1

1

£ Edit Timing Constraints

* Scratch Pad | |5 Properties | 3 Netlist |

Figure 87: Connect Selected Pins

14. In the Connect Net dialog box, select <const0> from the GROUND section.

# Connect Net

Hierarchy:
et or Bus:

Search: | O~
= GLOBAL_CLOCK

= GROUND
o
LT GND_2
I= POWER.
LT <constl>
I SIGNAL
-l gount_out
~-=lll# count_out_OBUF
I count_out_pre
I divClk_reg
- # mul_out_pre
-JF mult_out_pre_pre
I p_1_in_0
I gl_iportd
-7 sl_iportl_o_1
I sl_oporto

[N ——

Connect selected pins or ports with a net. ‘

=]

M »

[ ok || cancel |

Figure 88: Connect Net Dialog Box
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15. Click OK.
<constO0> is added to the Scratch Pad.

16. Collapse the <const0> signal.

The three pins that you connected now show check marks in the Connectivity column of the Scratch

Pad.

Scratch Pad —_ O o=
&%+ =E
Con PnR  Object Name
= I divClk_reg
I divClk_reg[25]
I divClk_reg[26]
I divClk_reg[27]
I divClk_reg[28]
| | <const0>
= B my_mult_0/in2
[ ] ® my_mult_0/in2[3]
[« ] * my_mult_0/in2[2]
2 my_mult_0/in2[1]

& ] * my_mult_0/in2[0]

LR

Figure 89: Scratch Pad Showing <const0> Connected to Pins

17. In the Scratch Pad, select the my_mult_0/in2[1] pin.
18. Click Connect Net.

The Connect Net dialog box opens.
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19. In the Connect Net dialog box, select <const1> from the POWER section.

20. Click OK.

-

[

Connect Net

Connect selected pins or ports with a net.

Hierarchy:

Met or Bus:

Search:

I= GLOBAL_CLOCK

= POWER

e T
= SIGMNAL
-2l count_out
--all# count_out_OBUF
-IT# count_out_pre
I divClk_reg
I mul_out_pre
I mult_out_pre_pre
IF p_1_in_0
07 sl_iport0
07 sl_iportl_o_1
I sl_oport0

[Eoal ekt 4

g

A Y

m

] [ Cancel

Figure 90: Connect Net Dialog Box

<constl> is added to the Scratch Pad.

21. Collapse the <const1> signal.
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The pin that you connected now shows check marks in the Connectivity column of the Scratch Pad.

Scratch Pad = 0.t X
AT+~
FnR  Object Name

= £ divClk_reg
I divCik_reg[25]
I divClk_reg[26]
[ divClk_reg[27]
I divClk_req[28]
+ I <constl>
# J <const0>
W B my_mult_0/in2
f & my_mult_0/in2[3]
B my_mult_0/in2[2]
_-m’ﬁﬂﬁﬂﬁi
& mry_mult_0/in2[0]

L4448 444 8

Figure 91: Scratch Pad Showing <constl> Connected to Pin

22. Select the my_mult_0/1in2 pin in the Scratch Pad.

This command highlights the pins in the currently open Schematic view window, and shows the
updated connections.

Note: Make sure that the Autofit Selection toggle button is highlighted in the Schematic window
S0 you can see the entire path, as shown in the following figure.

Scratch Pad Owe = | @ Device x | [ Package X |7l Schematic X | 0O X
SR — 5] 114 cCells 13VO0FPorts 254 Nets

Con PnR  Object Name = "

v = 7 divClk_reg =
v T divClk_req[25] O_\+ I_
+ I divClk_reg[26] mul_out_pre[7]_i_1 B
v T divClk_reg[27] Qg m_q%]m_u
4 I divClk_reg[28] Y
v T <constl> = LUTT
+ I <const= R
*’ ] —‘7 my_mult_0 z
. 1 e —
j :'; gm—mﬂﬁ-gmi{ﬂ in1[3:0] @ o[ 7: 01 S=defaut 35
_mult_| | - N y

v 4 D my_mult_o/in2[0] i V=E0010" in2[3:0 |

@ multiplier L

=l = i

s 4
+
B

# Scratch Pad | [ Properties | (] Netlist | ! ! Al

Figure 92: Resulting Schematic After Applying ECO Flow

Implementation www.xilinx.com 85
UG986 (v2016.4) November 30, 2016 Send Feedback


http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG986&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Implementation&releaseVersion=2016.4&docPage=85

& XILINX

23.

24.
25.

ALL PROGRAMMABLE. Lab 4: Vivado ECO Flow

When you observe the count signal on the LEDs, you only use 4 bits. The upper 4 bits are padded
with zeroes.

Now, you will use the ECO flow to observe counter bit 24 on LED 7. The first step is to analyze the
logic that drives count_out_reg[3].

From the Tcl Console, type the following command:
select objects [get _cells count out[3]_i_ 1]

This lets you quickly identify the LUT3 that drives the count_out_reg[3] register, which drives
LED 3. The inputs are:

o mul_out_pre_reg[7] for pin 10
0 count_out_pre_reg[3] for pin I1
0 tog_state_reg for pin 12
Click the Properties tab to view the cell properties and select the Truth Table tab.

Click Edit LUT Equation to view the equation for the LUT3. Note the LUT equation:
O=11 & 112 + 10 & 12

cell Properties R TS 7 Schematic x | § Device x | [ Package x ?Orx
= L ¥]| 104 Cells 1310 Ports 255 Nets
@ count_out{3]_i_1 - wroalw Q3 count_out_reg[2]
A FO=51|, g — =
R II I0 O=N&IR+I0&R2 - ® count_out{2]_i_1 Fo=2174 ~ =
00 0 0 [+ EDRE 2 FO=3[, Fo=27)
FO=4
Ea o LS mul_out_pre_reg[6] 2 B Fo=3ly, off2=t il Y Q
0 1 0 1 P o9\, A Fo=51|,
e 1 1 1 b ro=aua|
1 0 0 0 5 FO=41] LT3 L
A oA K & ro- CE o GeEcE FDRE
11 0 0 s o foslip count_out_reg[3]
101 01 1 = Fo=51| .
2 count_out[3] i 1 Fo=iilc
] FORE 3 ﬁ)ro:;m Fo=21l o
vl
B 3 i ro3f, Fo=1 Fo=1y o
& mul_out_pre_reg[7] o W o=ty
B FO=2174| LuT3 —FDRE
Fo=al| X t out 4
B rout offe=: & 7 count_out_reg[4]
- —iD count_out[4]_i_1 Fo=2174| .
A Fo=5L|, | FO=9p 0=1 roe27
®— 4 i Fom3ly, —=CE o FO=4
FDRE L fo=ily
Lur2 A Fo=51 |,
Edit LUT Equation... count_out[5] i_1
FO=9[— [FO=1
General | Properties | Power | Nets | Cell Pins | Truth Table T tog_state_reg 5 ﬁmj‘m Ol ‘ FDRE i
R =3y,
* Scratch Pad il Properties | G Netlist g I +

Figure 93: LUT3 Driving count_out_reg[3]
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26. From the Tcl Console, type the following command:
select _objects [get_cells count_out[7]_i_1]

Cell Properties I = & Device X | [ Package X | Schematic X 0w %
Ll 41510 3] 114 Cells 1310 Forts 254 Mets
(Ml count_out[7]_i_1 4= count_out[6]_i_1 Fo=2174| o
B o= glost FO=27 e =
o I0 0=I0&I - . ™ rO=j|Il ‘ romi| Qg
L = i FO=53
01 0 o LUT2 R
1 0 0 e
T T o FDRE
[ii| tog_state_reg count_out_reg[7’
ﬂ‘ O=2174 C FO=2174 C
| -=Zlce Qo= count_out[7]_i_1 Fo=2lce oo
= FO=1 D FO=9| 10 5] FO=1 FO=1 D
¥ FO=53| 7 3 FO=3| 1 i Fo=53|,
= TuT2
= FDRE FDRE
e @&
Edit LUT Equation...
General | Properties | Power | Nets | Cell Pins | Truth Table t
 Scratch Pad [ Properties | [ Netlist d Il C

Figure 94: LUT2 Driving count_out_reg[7]

This command selects the LUT2 that drives the count_out_reg[7] register, which drives LED 7 on
the KCU105 board. The only inputs are tog_state_reg for pin 10 and mul_out_pre_reg[7]
for pin I1. You need to replace the LUT2 with a 3-input LUT and connect the output of counter
register divClk_reg[24] to the additional input pin.

27. In the Vivado ECO Navigator, under Edit, click Create Cell.
The Create Cell dialog box opens.
a. Inthe Cell name field, enter ECO_LUTS3.
b. In the Search field, enter LUT3.

c. Select LUT3 as the cell type and copy the LUT equation O=11 & 12 + 10 & 12 from cell
count_out[3] i 1.

d. Click OK.
ECO_LUT3 is added to the Scratch Pad and the schematic.

e. Right-click the newly added ECO_LUT3 cell in the Scratch Pad, then select Mark and the color
red.

Note: Marking the ECO_LUT3 cell makes it easier to locate.
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.

¢ Create Cell | &3
Create a cell or an array of cells at a specified level of hierarchy.
Hierarchy: - D
Cell name: ECO_LUT3
[ create array: From 0= To 315
Cell type

Search: LUT3 (3 matches)
LUT3_D

LUT3_L

LUT Equation: O=I1 & !I2 + 10 & I2 ()
Location: Eixed
[ Create hierarchical cell
Cell reference name:

l OK l l Cancel

Figure 95: Create Cell Dialog Box

Because you copied the LUT equation from cell count_out[7]_i_1, the nets must be hooked up in
the same order, with the following connections:

e Netmul_out_pre[7] connected to pin 10

e NetdivClk_reg_n_0_[24] connected to pin I1

e Net tog_state connected to pin 12 of ECO_LUT3

28. Locate the tog_state net driven by the tog_state_reg register in the schematic and select it.

Alternatively you can select the net from the Tcl console by running the following command:

select_objects [get_nets tog_state]
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29. Connect the 12 pin of the newly added ECO_LUT3 cell by doing the following:

a. Hold down the CTRL key and select pin 12 in the Scratch Pad. This selects pin 12 in addition to
the already selected tog_state net.

b. Click Connect Net.

ECO Navigator «  scratch Pad —Ouw x @ Device X | [ Package x | i Schematic x 70O x
Edit A ATEEY - %] li5Cells 13TOPorts 254 Mets
Create Net Con PnR  Object Name m
- by - [VE]
* Create Cell v = I divClk_reg FORE
" v I divClk_reg[25] o count_out_reg[4]
o Create Port v T divClk_reg[26] - o
. v T divClk_reg[27] @« C
Create Pi -
L Genln v T divClk_reg[28] w Fo=2l g P
i Conpect Net v T <const1> £ rConj”l_UUt[ﬂ_"_}L Fo=1| Q
v I <consto> R -—'—im ofe= W Fo=s3
»¥ Disconnect Net v ¥ BB mymul_o/in2 o A B rosafyy 2
= Replace Debug Frobes v v & my_mult_0/in2[3] 0T FDRE
v v O my_mult_0/in2[2] (=
i Place Cell v D my_mult_0/in2[1] B
1 Unplace Cell v ¥ B my_mult_0/in2[0] ECO_LUT3
[ # ECO_LUT3 B el count_out_reg[5)
Run SIOD 8 ey 0 olve Fo=2174 . =
@ check ECO = oo B o En “r’;‘i i
1% Optimize Logical Design . + s ‘ A Fo=53 2
— count_out[5] i 1 —R
1 Place Design e r— L ‘
 Optimize Physical Desig & S E] I'D=J|r1 FDRE
e 1 count_out_reg[6
3 Route Design LUT2 _out_reg[6]
ro=2imf
Report runt antA1 01 FO=| g IR =
£ Edit Timing Constraints  Scratch Pad | [5) Properties | 3 Netlist d Ul G

Figure 96: Scratch Pad and Schematic Showing ECO_LUT3 Added

30. Locate the mul_out_pre[7] net in the schematic and select it.

Alternatively, you can select the net from the Tcl Console by executing the following command:
select_objects [get_nets mul_out pre[7]]

31. Connect the 10 pin of the newly added ECO_LUT3 cell by doing the following:

a. Hold down the CTRL key and select pin 10 in the Scratch Pad. This selects pin 10 in addition to
the already selected mul_out_pre[7] net.

b. Click Connect Net.

A dialog box opens, asking if you want to unset the DONT_TOUCH property on the net
mul_out_pre[7] net to continue.
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c. Click Unset Property and Continue.

¢ Connect Nets =3

[9] The objects below are marked 'DON'T TOUCH', a property which must be removed
= to continue. Do you want to remove the properties and continue?

Met: mul_out_pre[7]

‘ Unset Property and Continue ‘ | Cancel

Figure 97: Connect Nets Dialog Box for Nets with DONT_TOUCH Property

Note: Because the mul_out_pre[7] net previously had been connected to an ILA debug probe, the
MARK_DEBUG and DONT_TOUCH properties have been applied to the net to preserve it for debug. In
order to change the connectivity of the net, the DONT_TOUCH property first has to be removed.

32. Locate the divClk_reg_n_0_[24] net in the schematic and select it.

Alternatively, you can select the net from the TCL console by executing the following command:
select _objects [get nets divClk reg n 0 [24]]

33. Connect the 11 pin of the newly added ECO_LUTS3 cell by doing the following:

a. Hold down the CTRL key and select pin 11 from the Scratch Pad. This selects pin 11 in addition
to the already selected divClk_reg_n_0_[24] net.

b. Click Connect Net.

Next, you need to connect the updated logic function implemented in the newly created LUT3 to
the D input of count_out_reg[7]. The first step is to delete the LUT2 that was previously
connected to the D input.

34. Select the LUT2 count_out[7]_i_1 in the schematic window.
Alternately, you can select it by executing the following command in the Tcl console:
select _objects [get _cell count out[7] _i_1]

35. From the toolbar, click the Delete button * to delete the selected cell.

36. Select the net connected to the D input of the count_out_reg[7] register in the schematic
window.

Alternatively you can select the net from the TCL console by executing the following command:
select_objects [get nets count out[7] _i_1 n O]

37. Connect the O pin of the newly added ECO_LUTS3 cell by doing the following:
a. Hold down the CTRL key and select pin O from the Scratch Pad.
b. Click Connect Net.
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Figure 98: Connecting ECO_LUT3 Output

The ECO modifications are completed.

Step 5: Implementing the ECO Changes

Before you place and route the updates, you need to check for any illegal logical connections or other
logical issues introduced during the ECO that would prevent a successful implementation of your
changes.

1. In the Vivado ECO Navigator, under Run, click Check ECO.
The following figure shows the messages generated by the ECO DRC.

e The two Critical Warnings are due to the partially routed signals that are a result of the ECO and
will be cleaned up during incremental place and route.

¢ No other warnings have been issued and you are ready to implement the changes.

DRC - drc_1 (2 violations) 7 -0 a %
A [¥]® 2 critical warnings
=
., Mame Sevent’yf1 Details
=
= |= @ All Violations (2)
e =@ Implementation (2)
i@ Routing (2)
[+ Chip Level (2)
[21® RTSTAT-5 (1)
! . @ RTSTAT #1 Critical Warning 7 net(s) have a partial antenna. The problem bus(es) and/or net(s) are divClk reg, mul out pre[7], probeDelayl reg[31[5], tog state.
(=1 @ RTSTAT-6 (1)

L~ 8 net(s) have a partial conflict. The problem bus(es) and/or net(s) are count out{71 i 1 n 0, divClk reg, probeDelayl reg[31[5],
@ RTSTAT #1  Critical Warning ) s\ | ogico, GLOBAL_LOGIC.

drc_1 (2 violations) 4F 8

Figure 99: Check ECO DRC Messages

Because you added additional logic, you need place the logic using the incremental place, and then
route the updated net connections using incremental route.
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2. In the Vivado ECO Navigator, under Run, click Place Design.

The Place Design dialog box opens, allowing you to specify additional options for the
place_design command. For this exercise, do not specify additional options.

3. Click OK.

4. Vivado runs the incremental placer.

¢ Place Design £
Run design placement with the specified
options. ’
Options:
OK l | Cancel

Figure 100: Place Design Dialog Box

At the end of the place_design step, the incremental Placement Summary is displayed in the TCL
Console.

Bt e e E P e e e P P e +
|Incremental Placement Summary |
Bt e e E P e e e P P e +
| Twpe | Count | Percentage |
Bt e e E P e e e P P e +
| Total instances | 4207 | 100,00 |
| FReused instances | 4205 | 9985 |
| Non-reused instances | 2 0.05 |
| Hit | 1] 0,02 |
| Discarded i1Tegal placement due to netlist changes | 1] .02 |
Bt e e E P e e e P P e +
|Incremental Placement Runtime Summary |
Bt e e E P e e e P P e +
| Initialization time(elapsed secs) | f.50 |
|  Incremental Placer time{elapsed secs) | o668 |
A e e +

Figure 101: Post-Place Incremental Reuse Summary

The incremental placement summary shows that the following two cells did not have their previous
placement reused:

0 The new ECO_LUTS3 cell, which had to be placed from scratch

0 The count_out_reg[7] cell, which had to get updated placement due to the placement of the
ECO_LUT3 driving it

5. In the Vivado ECO Navigator, under Run, click Route Design.
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The Route Design dialog box opens.

¢ Route Cesign x

Depending on selection, route all or a
portion of a design. ‘

@) Incremental Route
Route selected pin
Route selected non-Power nets

Route selected Power nets

(04 J | Cancel

Figure 102: Route Design Dialog Box

Depending on your selection, you have four options to route the ECO changes:
0 Incremental Route: This is the default option.
0 Route selected pin: This option limits the route operation to the selected pin.
0 Route selected non-Power nets: This option routes only the selected signal nets.
0 Route selected Power nets: This option routes only the selected VCC/GND nets.
In this case, the best choice is to route the changes you made incrementally.
6. Select Incremental Route.
7. Click OK.

At the end of the route_design step, the incremental Routing Reuse Summary displays in the Tcl
Console.

| Tvpe | Count | Percentage |
|Fully reused nets | 3200 o9 88 |
|Partially reused nets | 3 .09 |
|Man-reused nets | 1] 003 |

Figure 103: Post-Route Incremental Reuse Summary

Most of the nets did not require any routing and have been fully reused.

TIP: It is a good idea to run report_route_status after the route operation to

O make sure all the nets have been routed and none have any routing issues. This (s
especially true if you only routed selected pins or selected nets and want to make sure
you have not missed any routes.
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8. Inthe Tcl Console, run the report_route_status command.

The Design Route Status looks similar to the following status.

Design Route Status

# nets

#oof Togical nets. . i e e enennnnnnns H 4444
# of nets not needing routing.......... H 1235 :

# of internally routed nets........ : 1177

# of nets with no loads............ : 58

# of routahle nets. . i : 3200

# of fully routed nets............. : 3209

# of nets with routing errors.......... H 0

Figure 104: Design Route Status Post Implementation

Before you generate a bitstream, run the ECO DRCs on the design.

9. In the ECO Navigator, click Check ECO. Make sure no violations are reported.

¢ Run DRC X

':0:' No Violations Found.

Figure 105: Post Implementation Check ECO Results

10. In the Vivado ECO Navigator, under Program, click Save Checkpoint As.

The Save Checkpoint As dialog box opens and you can specify a name for the checkpoint file to
write to disk.

11. Click OK to save a checkpoint file with your changes.

¢ Save Checkpoint As x

Create a checkpoint file that contains the netlist, XDC constraints, and the physical database.

Checkpoint file: | C:/Data/Vivado_Tutorial/project_ECO_lab/ECO/checkpoint_1.dcp \_l

| 0K || Cancel |

Figure 106: Saving ECO Modifications to a New Checkpoint

12. In the Vivado ECO Navigator, under Program, click Generate Bitstream.

The Generate Bitstream dialog box opens.
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You can specify a name for a Bit file and select the desired options for the write_bitstream
operation.

13. Click OK to generate a bitstream with your changes.

-

=

¢ Generate Bitstream

Create a programming file from the current design

Bit File |ado_Tutorial/project_ECO_lab/ECO/project_top_routed.bit D
Options

-raw_bitfile
-mask_file
-no_binary_bitfile
-bin_file
-readback_file
-logic_location_file
-verbose

More Options

1

Select an option above to see a description of it

0K ] [ Cancel

Figure 107: Generate Bitstream Dialog Box

14. In the Vivado ECO Navigator, under Program, click Write Debug Probes.
The Write Debug Probes dialog box opens.

-

¢ Write Debug Probes

=

Write debug probes to a file.

File Mame: ‘ivado_Tutorial/project_ECO_lab/ECO/probes_1.ltx B

Ovenwrite

OK ” Cancel l

Figure 108: Write Debug Probes Dialog Box

You can specify a name for a .Itx file for your debug probes.
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15. Click OK to generate debug probes file (LTX).

This command allows you to generate a new .Itx file for your debug probes. If you made changes to
your debug probes using the Replace Debug Probes command, you need to save the updated
information to a new debug probes file to reflect the changes in the Vivado Hardware Manager

16. Follow the instructions in Step 4: Making the ECO Modifications to download the generated
bitstream programming file and debug probes file into the target FPGA device using the Hardware
Manager to check your ECO modifications.

Step 6: Replacing Debug Probes

Another powerful feature of the Vivado ECO flow is the ability to replace debug probes on a previously
inserted Debug Hub. After the debug probes have been replaced, a new LTX file can be generated that
contains the updated debug probe information.

To replace a debug probe in your previously modified design, do the following:
1. From the main menu, select File > Open Checkpoint.

The Open Checkpoint dialog box opens.

¢ Open Checkpoint @
Lookin: | | ECO =k OGS E-
v checkpoint_1.dcp| Recent Directories
- ¢ top_routed.dcp | C:/Data/Vivado_Tutorial/project_ECO_lab/ECO -
R T I
ecent ems L\\, File Preview
! File: checkpoint_1.dcp
Directory: C:/Data/Vivado_Tutorial/project_ECO_lab/ECO
Desktop Created: Yesterday at 15:50 PM

Accessed: Today at 16:26 PM
Modified: Yesterday at 15:50 PM
5 Size: 2.1 MB
My Docum... Type: Checkpoint design
Owner: XLNX\fmuelle
A

Computer

=
“‘ File name: checkpoint_1.dcp

Network e of type: | vivado Checkpoint Files (.dcp)

Figure 109: Open Checkpoint Dialog Box

2. Browse to the C:/Data/Vivado_Tutorial/project ECO_lab/ECO directory and select the
previously saved checkpoint_1.dcp file.

3. Close any previously open checkpoints.

4. From the main menu, select Layout > ECO.

5. Inthe Vivado ECO Navigator, under Edit, click Replace Debug Probes.
The Replace Debug Probes dialog box opens.
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In this example, you will replace the net reset_vio that is connected to probe4 of u_ila_0 with
the net toggle_vio.

6. Scroll to the bottom of the probes for u_ila_0 in the Replace Debug Probes dialog and click the
icon next to the reset_vio net name in the Probe column.

¢ Replace Debug Probes

Use the Edit Probes button to replace one or more debug probes. To reflect
these changes in the Vivado Hardware Manager, regenerate the debug probes ‘

file (LTX).

Search:

1 B4

Name

g LN L
~@Ch2
~@Ch3
~@Ch4
~@Chs
~@Ch6
~@Ch7

== 0N

@ Cho
~@ch1
@ Ch2
@ Ch3

@ Cho
~@ch1
@ Ch2
~@Ch3
@ Cha
@ Ch5
@ Ch6
~@Ch7

[=hi probe3 (1)

Elr_"? probe4 (1)

~@Cho

(=N= probe5 (1)

Probes changed: 0

Probe

ol %% COUNT_OUT_UBUFLL|
o[ # count_out_OBUF[2]
o[ # count_out_OBUF[3]
o[ # count_out_OBUF[4]
o[ # count_out_OBUF[5]
o[ # count_out_OBUF[6]
o[ # count_out_OBUF[7]

Ex5

=+ probel (4)

=& probe2 (8]

# count_out_pre[0]
# count_out_pre[1]
# count_out_pre[2]
# count_out_pre[3]

& mul_out_pre[0]
& mul_out_pre[1]
& mul_out_pre[2]
& mul_out_pre[3]
& mul_out_pre[4]
& mul_out_pre[5]
& mul_out_pre[6]
& mul_out_pre[7]

# pause_vio
I reset_vio

I state

oK

Figure 110: Replace Debug Probes Dialog Box

The Choose Nets window opens.
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7. Choose a new net to connect to the debug probe probe4 by doing the following:

a. Type toggle_vio in the search field of the Choose Nets dialog box.
b. Click Find.

c. Select the toggle_vio net, and move it to the Selected names section.

-

¢ Choose Nets

Choose nets to replace existing probes.

toggle_vio Selected names: 1

Find results: 0

toggle_vio

ttH+ 3

Use the buttons on the right to mave items
o this list,

1 of 1 selected

= > = =

Ok

] [ Cancel

Figure 111: Choose Nets Dialog Box

8. In the Replace Debug Probes dialog box, click OK.

9. In the message window that opens, click Unset Property and Continue.
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¢ Replace Debug Probes £

-je} 1 probe could be connected. The objects below are marked 'DON'T TOUCH',
= a property which must be removed to continue. Do you want to remove the
properties and continue?

Net: reset_vio

Unset Property and Continue J ‘ Cancel

Figure 112: Unset DONT_TOUCH Property Dialog Box

10. Repeat steps 5 through 14 of Step 5: Implementing the ECO Changes to generate an updated
design checkpoint, bitstream file, and probes file (LTX).

The updated debug probes file has the reset_vio net for probe4 replaced with net
toggle_vio, which you can verify when you program the device with the updated bit file and
debug probes file.

hw_ila_1 _oOa
Waveform - hw ila 1 -2 X
#*[| 1A Status:Idle -

+ Name

_ ™ count_ou..._1[7:0]
bl B2 ™ count_out_pre[3:0]
Pl B mul_out_pre[7:0]
P . pause_vio

Ik, state

Dashboard Options

Updated at: Z0le-Apr-19 17:50:14 -

Figure 113: ILA Waveform with Update Debug Probes

Conclusion

In this lab, you did the following:
e Made changes to the previously implemented design using the Vivado ECO flow.
¢ Implemented the changes using incremental place and route.
e Generated a bitstream and probes file with your changes to configure the FPGA.

e Used the Replace Debug Probes command to switch the sources for debug probes in the
design.
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Legal Notices

Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the maximum
extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES
AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort,
including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in
connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss
or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party)
even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no
obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not
reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and
conditions of Xilinx’s limited warranty, please refer to Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos; IP
cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or
intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products
in such critical applications, please refer to Xilinx’s Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”") UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS,
THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A
SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING
LIMITATIONS ON PRODUCT LIABILITY.

© Copyright 2012-2016 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Zyng, and other designated brands included herein
are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.
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